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Welcome to Sprint

Sprint built the largest all-PCS nationwide network with advanced
multimedia services and clear calls, reaching more than 230 million

people for clarity you can see and hear. We built our network to give you what
we believe you really want from a wireless phone, clear sound, private
conversations and time-saving features.

But with Sprint, you can do something even more far-reaching – simplify
your life. Our advanced technology is designed to grow with your
communications needs so that one day you'll be able to rely entirely on your
PCS Device to stay connected.

This guide will familiarize you with our technology and with your new 
PCS Device through simple, easy-to-follow instructions. If you have already
reviewed the Start Here Guide, which was packaged with your new device, then
you're ready to explore the advanced features outlined in this guide. 

If you have not read your Start Here Guide, go to Section One - Getting Started.
This section provides all the information you need to quickly activate 
the phone function, set up your voicemail and much more. It also contains
information on how to contact Sprint should you have questions about
service, want to purchase additional products or services, or just to check your
account balance.

Thank you for choosing Sprint. 
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Introduction to this
Online User’s Guide

This Online User's Guide introduces you to PCS Service and all the features
of your new device. It's divided into four sections:

� Section 1: Getting Started

� Section 2: Understanding Your Device

� Section 3: Using PCS Service Features

� Section 4: Safety and Warranty Information

Throughout the guide, you'll find tips that highlight special shortcuts 
and timely reminders to help you make the most of your new device and
service. The Table of Contents  will help you locate specific information
quickly.

You'll get the most out of your device if you read each section. However, if
you'd like to get right to a specific feature, simply turn to that page. Follow the
instructions in that section and you'll be ready to use your device in no time.

Tip: You can print out this guide to keep on hand or view it online. 

32
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Section 1
Getting Started 5

Getting Started

4

Section 1
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Section 1A

Setting Up Service

In This Section

� Getting Started With PCS Service

� Getting Help

This section walks you through the basics of setting up service for 
the phone function on your device, including unlocking and activating

the phone function, and how to contact Sprint for assistance with your PCS
Service.

Section 1: Getting Started
1A: Setting Up Service 76
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Getting Help
Visiting Our Web Site

Stop by www.sprintpcs.com and log on to get up-to-date information on
PCS Services, options and more. 

You can also:
� Review coverage maps
� Learn how to use voicemail
� Access your account information
� Purchase accessories
� Add additional options to your service plan
� Check out frequently asked questions
� And more

PCS Customer Solutions

Claire, your virtual service representative is available to assist you 24
hours a day, seven days a week. Visit her at www.sprintpcs.com by logging
on and clicking on Claire’s Directory for Service Solutions.

Receiving Automated Invoicing Information

For your convenience, your device gives you access to invoicing
information on your PCS Account. This information includes balance
due, payment received, invoicing cycle and the amount of minutes and/or
data used since your last invoicing cycle. (A nominal fee and/or airtime
charges may apply.) 

To access this information:
� Tap .

Note: This service may not be available in all Affiliate markets.

4

Section 1: Getting Started
1A: Setting Up Service 9

Getting Started With PCS Service
Determine if the Phone Function is Already Activated

If you received your device in the mail or purchased it at a Sprint Store, it
probably has been activated. All you need to do is unlock the phone function.

If the phone function is not activated, please refer to the Start Here Guide
included with your device.

Unlocking the Phone Function

Follow these steps to unlock the phone function:

1. Slide the Radio Standby Switch to the upper side to turn the phone
function on.

2. Tap Tools.

3. Select Unlock Modem.

4. Enter your 4-digit lock code and tap OK.

Tip: If you can’t recall your lock code, try using the last four digits of
either your Social Security number or PCS Phone Number or try 0000. If
none of these work, call PCS Customer Solutions at 1-888-211-4PCS (4727).

Activating the Phone Function

To activate the phone function, follow the directions in the Start Here
Guide that was included with your device. 

Section 1: Getting Started
8 1A: Setting Up Service
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PCS Directory Assistance

PCS Directory Assistance provides a variety of services, including
residential, business and government listings; assistance with local or
long-distance calls; movie listings; hotel, restaurant and shopping
information and major local event information. There is a per-call charge
and you will be billed for airtime.
� Tap .

PCS Operator Services

PCS Operator Services can provide assistance in placing collect calls or
calls billed to a local telephone calling card or a third party.
� Tap .

For more information or to see the latest in products and services, visit us
online at www.sprintpcs.com.

Note: PCS Operator Services may not be available in all 
Affiliate markets.

0

114
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Understanding Your
Device

Section 2
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Section 2A

Your Device: The Basics

In This Section

� Part Names and Function

� Battery Charging

� Initial Setup

� Setup Options

� Connecting to a Computer

� Today Screen

� Programs

� Navigation Bar and Command Bar

� Pop-up Menus

� Notifications

� Entering Information

� Entering Text Using the Input Panel 

� Finding and Organizing Information

� Customizing Your Device

This section will guide you through the basics of your device and you’ll be
on your way to using it in no time.

Section 2: Understanding Your Device
2A: Your Device - The Basics 1312
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Section 2: Understanding Your Device
2A: Your Device - The Basics 15

Part Names and Function

Section 2: Understanding Your Device
14 2A: Your Device - The Basics

Touch Screen

Program Button
 1, 2, 3 & 4
(From the Left)

Record Button
(Program Button 5)

Incoming Call / System Notification LED

Fixed Antenna

Radio Standby Switch

Charging LED

Microphone

TALK Button
END Button

Cursor Button / 
Navigation Button

Power Button / 
Front Light Button

Speaker

AC Adapter Jack

Cradle Connection Port

Back View

Stylus Holder

Stylus

SD Card Slot
Headset Jack

Reset Switch

Infrared Port

USB Cradle

Color Panel

Hand Strap Attachment
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Power Button / Front Light Button

Press this to turn the device and the front light on/off.
Power button When the power is off When the power is on

Press it quickly. The power turns on. The power turns off.
Press and hold. The power turns on. The front light alternately

turns on/off.

Even if the power is turned off, pressing the program button turns the
power on and the program screen is displayed. (However, you can change
the setting. See “Setting Power” on page 49.)

When using the device under high ambient temperatures and the
temperature inside of the device goes up (to about 144°F or more), the
power is forcibly turned off. In this case, after the temperature inside of the
device cooled down, turn the power on and use the device under
appropriate ambient temperatures. (144°F=62°C)

Battery Switch

The Battery Switch supplies/cuts the battery power to the device. When
shipped, the setting is “Stop.” Before using your device for the first time:

1. With the device in hand, gently remove the Color Panel on the right side
of the device, using the stylus at the top of the Color Panel.

Section 2: Understanding Your Device
16 2A: Your Device - The Basics

2. Confirm that the Radio Standby Switch on the left side of the device is
set to the lower side (OFF), then slide the Battery Switch on the right
side of the device to “Supply” (lower side).

3. Reattach the Color Panel.
� The proper way to reinstall the Color Panels is to carefully insert the

two small right angle tabs and the single straight tab at the bottom
while simultaneously holding and bending the very top section away
from the device. After all three tabs are seated and pushed down into
place, then push the top section, that you are holding away from the
unit, back in until you feel a distinct “snap”.

Note: Returning the Battery Switch to the “Stop” (the upper side) resets
the device back to its factory settings (All stored data will be deleted) -
initial setup will need to be repeated. To move to the “Stop” side, slide the
Battery Switch while inserting the stylus into the Battery Switch Lock.

Note: Do not use excessive force in detaching or reattaching the Color
Panel. Failure to comply with the above procedures may cause damage
to the tabs or other parts of the device.

Battery Switch

Battery Switch Lock

Section 2: Understanding Your Device
2A: Your Device - The Basics 17
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Using the Stylus

Use only on touch screen for menu selection or data input.
� Tap: Touch the screen once with the stylus to open items

and select options.
� Drag: Hold the stylus on the screen and drag it across to

select text and images. Drag in a list to select multiple
items.

� Tap and hold: Tap and hold the stylus on an item to see a list of
actions available for that item. On the pop-up menu
that appears, tap the action you want to perform.

Note: Only use the supplied stylus on the touch screen. If the stylus tip
becomes damaged, replace it with a new one. Using a ballpoint pen or
damaged stylus may damage the screen.

About Cursor Button

Navigate the cursor on screen by pressing the upper, lower, right or left part
of the cursor button. Press the center of the button to select an option or
program.

Note: The cursor movement depends on the screen. When the cursor is
at the right or the left side of the screen, it may not move.

Section 2: Understanding Your Device
2A: Your Device - The Basics 19
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Charging LED 
� Steady orange ..............Built-in battery charging

If the battery is completely drained, the device
will have to charge (LED will display orange)
for a period of time prior to use.

� Flashing yellow............Charging has stopped due to extreme
temperatures. Charge at a temperature of
approximately 41°F - 95°F (5°C and 35°C).

� Steady green.................Built-in battery fully charged.

Incoming Call / System Notification LED
� Fast flashing orange ....Incoming call

(Approx. 2Hz)
� Slow flashing orange ...Incoming message

(Approx. 1Hz) Incoming voicemail
Missed call 
Alarm as set through Calendar or 
Tasks

Radio Standby Switch

Determines functionality of device. To turn ON, slide Radio Standby
Switch to the upper side.
� ON ............Can be used as phone to make and receive calls
� OFF...........Cannot function as a phone
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Phone Headset

The supplied Phone Headset can be used to make or receive phone calls.
When the Phone Headset is inserted into the device, the microphone and
speaker on the main unit will become inactive.

Also, this microphone can be used as a recorder.

This device’s phone component can be used with the Phone Headset/
Remote Control Unit or as a speakerphone. Unlike conventional cell
phones, it is not designed to be held against the head in conversation.
Such use of the phone is contrary to the design of the product and is
strongly recommended against. Please use the device with the Phone
Headset/Remote Control Unit or in speakerphone mode. For instructions
on how to use the device with the Phone Headset/Remote Control Unit or
as a speakerphone, please refer to page 60 of this guide.

Note: Do not use the Phone Headset/Remote Control Unit when turning
on and off the device or when connecting or disconnecting the Phone
Headset/Remote Control Unit to/from the device because a loud noise
may be emitted.

Microphone To Headset Jack

Clip
You can attach the 
Phone Headset to your 
pocket, etc., by using this clip.
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Remote Control Unit

The supplied Remote Control Unit can be used to listen to audio playback.
Combined with the headphones (sold separately), it can be used to receive
phone calls. When the Remote Control Unit is inserted into the device, the
microphone and speaker on the main unit will become inactive.

Also, this microphone can be used as a recorder.

During a call, it is not possible to adjust the volume with the Volume button.

Use ø 3.5mm mini-plug type headphones to connect to the Remote
Control Unit.

This device’s phone component can be used with the Phone Headset/
Remote Control Unit or as a speakerphone. Unlike conventional cell
phones, it is not designed to be held against the head in conversation.
Such use of the phone is contrary to the design of the product and is

Hold Switch
All other remote
keys become inactive 
when “HOLD” is set. 
The TALK/END button is active.

Stop Button

+
–Adjust 

Volume

Play / Pause
Skip to the 
next song

Play a 
previous song

TALK / END 
Button

Play / Pause, FF, 
REW Switch

To Headset Jack

Clip
You can attach the Remote Control Unit
to your pocket, etc., by using this clip.

Stereo Headphones Jack

Microphone

Volume Button

Headphones 
(sold separately)

Remote Control Unit
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strongly recommended against. Please use the device with the Phone
Headset/Remote Control Unit or in speakerphone mode. For instructions
on how to use the device with the Phone Headset/Remote Control Unit or
as a speakerphone, please refer to page 60 of this guide.

Battery Charging
When using the device for the first time, set the Battery Switch to the supply
side (see page 16), then fully charge the battery. 

Charging the Battery

You can use two charging methods.

When you connect the AC Adapter to the device, turn the power off.
� Connect the supplied AC Adapter to the cradle as shown in the figure

below, and then insert the device into the cradle.

� Connect the supplied AC Adapter to the device as shown in the figure
below.

Section 2: Understanding Your Device
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Note: Charge the battery in an environment between 41°F - 95°F (5°C
and 35°C). Temperatures outside this range may pause the charging
process. Refer to page 18 for additional information on charging.

Note: When charging the battery for the first time, or immediately after
setting the battery switch to the supply side, fully charge the battery. If
the battery is not fully charged, the remaining battery power will not be
accurately displayed.

Maximizing the Battery Operating Time
� Whenever possible, use the device with the AC Adapter – especially when

it is connected to your computer.
� Select the short powered-off time in the setting menu. This will shorten

the time the unit will remain on if not used. See “Setting Power” on
page 49 for more information.

� Turn off the front light.
� Set the screen brightness to power savings mode (front light off) or

shorten the front light turn-off time. See “Setting the Front Light” on
page 48 for more information.

� For optimal performance use in an environment between 59°F - 77°F
(15°C and 25°C). Anything outside this temperature range may
decrease the operating time.

Battery Life

The built-in battery has a limited life that will gradually decrease after
repeated charging. Replace the battery when you notice a dramatic
decrease in battery performance. When a replacement is needed, please
request the dealer from whom your device was purchased to assist you.

Battery Charge Level and Stored Data Protection

If the battery charge level becomes extremely low or completely
discharged, stored memory data will be deleted. As soon as the low battery
status icon or the alarm message appears, immediately connect the AC
Adapter to the device so it can charge.
� The battery gradually discharges even when not in use. If not used for a

long time, it may completely discharge.
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8. After power up is completed, use the stylus to tap on the Admin pull-up
menu at the bottom of the screen, and select Activation Wizard. If your
device has not yet been activated, the Activation Wizard will
automatically start when you turn on the radio in your device.

9. Tap Next three times.

10.On the fourth screen, you will be prompted for a lock code. Use the
keypad to enter the 6-digit lock code given to you by the Sprint
Customer Solution representative, then tap Next.

11.Enter the mobile phone number given to you by the Sprint Customer
Solution representative, then tap Next.

12.Tap Next on the last screen, and the device will begin to initialize using
the data you have just entered.

Section 2: Understanding Your Device
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� It is strongly recommended that you save the device’s memory data to
your computer or a storage card. The manufacturer is not responsible
for data changed or lost due to battery discharge. For back up, see
“Backing Up” on page 137.

Initial Setup
When using your device for the first time, completely charge the battery
then follow the initial setup procedures below:

1. Press the Power button and when the welcome screen appears, tap the
screen with the stylus to start the setup process.

2. When the align screen appears, follow the directions for adjusting the
touch screen until the stylus screen appears.
� If a finger or any other object touches the screen during a correction,

it will be cancelled. Repeat the correction procedure.

Note: To display the align screen after the initial setup process, press
the Record button while pressing the center of the navigation button, or
by tapping , Settings, System, and then Screen.

3. Read and understand how to use the stylus, then tap Next. 

Note: See “Using the Stylus” on page 19 for more information.

4. Read and understand pop-up menu operation, then tap Next.
� Read the on-screen explanation and then operate the screen.

Display the pop-up menus, and cut and paste the data according to
the screen instructions. When this stage is complete, tap Next.

5. Follow the directions for setting the location, then tap Next.

6. When the complete screen appears, initial setup is finished. After
tapping the screen, the Today screen will appear and the device will be
ready to use. See “Today Screen” on page 28 for more information.

7. Slide the Radio Standby Switch on the left side of the device to the upper
side (ON) to activate the phone function.
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Connecting to a Computer
Before connecting your device to a computer, check the following.
� ActiveSync® is on your computer. (For installation procedures of

ActiveSync®, see page 85.)
� The device is turned off.
� The computer you’re connecting has an available USB port for the

cradle.

To connect using the supplied USB cradle:

1. Connect the USB cradle to your computer as shown in the illustration
below.

2. Insert the device into the USB cradle.

Setup Options
Method of Setting Card into SD Card Slot

Inserting a card:

1. Turn off the power.

2. Insert the card with its contact surface (metal contact surface) facing
backward into the device.

Note: An SD dummy card is loaded in the SD card slot at purchase.
Remove the SD dummy card before inserting the card.

Removing a card:

1. Make sure that no application is accessing the SD card.

2. Turn off the power.

3. Lightly press down on the card until a clicking sound is heard. The card
will pop out slightly from the slot.

4. Pull the card straight up to remove.

USB port

Contact surface
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Following are some of the status icons you may see.

Note: If more notification icons need to be displayed than there is room
for on the screen, the will display. Tap the icon to view all the
notifications.

Phone Function Status Icons:

When the phone function is activated, the following icons may be
displayed on the command bar of the Today screen.

Make sure that the connector on the cradle is inserted into the port on the
bottom of the device. Data can not be transferred if the connection is not
made.

When your device is properly inserted into the cradle, your device will turn
on automatically and ActiveSync® will automatically open on your
computer.

Note: Avoid using your device in environments that are likely to be
affected by static electricity or are prone to high electrical noise. If you
connect your device to a computer via the docking cradle for data
transfer or data restoration purposes, Sprint will not be responsible for
any device or computer malfunction, problems with data transfer or data
modification/loss that may occur in these environments.

Today Screen
The Today screen appears when you turn on your device after 4 hours of
inactivity. It can be accessed by tapping and then Today.

Tap to switch
to a program.

Tap to change date and time.
Tap to open information setting.

Your day at a glance.

Tap to view connection status.Tap to create 
a new item.
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Meaning

Not connected to the network
Connected to the network
There is a missed call
There is an unread message
There is a voicemail message

Meaning

Turns all sounds on and off and changes the volume level 
Battery charging 
Battery is low
Battery is very low 
Battery is full
Active connection
Synchronization is beginning or ending
Synchronization in process
Notification that a new program or system update is
available
Instant message received
Email message received

Status Icon

Status Icon
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Navigation Bar and Command Bar
The navigation bar, located at the top of the screen, displays the active
program and time, and allows you to switch programs and close screens. 

The command bar at the bottom of the screen performs tasks in the open
program, and includes menu names, buttons and the Input Panel button.
Tap New to create a new item in the program.

� Tap on the navigation bar to view notification messages.
� Tap on the navigation bar to change the volume or mute the

device.
� Tap on the displayed time on the navigation bar to display the

current date and the next schedule.

� Tap New on the command bar to open a new option.
� Edit and Tools on the command bar are the menu names.
� is the Input Panel button on the command bar.

Note: If you tap on the right of the navigation bar, you can close that
program screen. Also, if you tap on the navigation bar, you can close
that screen.
To end the program, tap , Settings, System, Memory and Running
Programs, and select the program you wish to end, then tap Stop.
You can also end the program with Home. 

Programs
Switch from one program to another by using the menu. To access
programs not listed on the drop down menu, tap , Programs, then the
desired program. 

You can also switch to another program by pressing any of the five
program buttons located on the front and side of the device. The icons
above the buttons identify the factory set programs (from left to right) –
Calendar, Tasks, Home and Contacts. The Record button on the side is for
voice recording. To reprogram these buttons to activate other programs,
see page 43, “Adjusting Settings.”

The following table is a partial list of programs on your device. 

In addition to the programs listed above, Windows MediaTM Player, Backup,
Calculator, File Explorer, Home, Infrared Receive, Microsoft Reader,
Terminal Services Client, PCS connection, Solitaire are pre- installed.

Note: The program can be launched by using Home. See “Home” on
page 132.
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Icon Program

ActiveSync®

Calendar

Contacts
Inbox
Pocket Internet
Explorer
Notes

Tasks
Pocket Excel

MSN® Messenger

Pocket Word

Description

Synchronize information between your
device and your computer.
Keep track of your appointments and create
meeting requests.
Keep track of your friends and colleagues.
Send and receive email messages.
Browse Web and WAP sites, and download
new programs and files from the Internet.
Create handwritten or typed notes,
drawings, and recordings.
Keep track of your tasks.
Create Excel spreadsheets or view and edit
Excel spreadsheets created on your computer.
Send and receive instant messages with
your MSN® Messenger contacts.
Create new documents or view and edit Word
documents created on your computer.
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Entering Information
Options for entering new information include:
� Using the input panel to enter typed text.
� Writing or drawing pictures directly on the screen.
� Recording a message by speaking into the microphone.
� Using Microsoft® ActiveSync® to synchronize or copy information

from your computer to the your device.

Entering Text Using the Input Panel 
Use the input panel to enter information in any program by either typing
using the soft keyboard, or by writing using the Letter Recognizer, Block
Recognizer or Transcriber. With either option the characters will appear as
typed text on the screen.

To view/hide the input panel, tap the Input Panel button. Tap the arrow
next to it to see your options. 

Pop-up Menus
Pop-up menus provide quick access to select an action for an item, and
vary with each program. To access a pop-up menu, tap and hold the stylus
on the item you want to perform the action on. When the menu appears,
lift the stylus and tap the desired action. Tap anywhere outside the menu
to close it.

Notifications
Your device can remind you when you have an appointment or task
scheduled, or serve as an alarm clock. Notification options include:
� A message box on the screen
� A sound (which you select)
� A flashing light

To select reminder types and sounds, tap , and then Settings. In the
Personal tab, tap Sounds & Notifications. The selected options will apply
for the entire device.
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Using Block Recognizer:

With Block Recognizer you can use the stylus to input character strokes
similar to those used on other devices.

1. Tap the arrow next to the Input Panel button and then Block Recognizer.

2. Write a letter in the box — it will automatically be converted to typed text
on the screen.

For specific instructions, open Block Recognizer and tap the question
mark icon next to the writing area.

Using Transcriber:

With Transcriber you can write anywhere on the screen using the stylus
just as you would on paper. Unlike Letter Recognizer and Block
Recognizer, you can write a sentence or more of information. Then, pause
and let Transcriber change the written characters to typed characters.

1. Tap the arrow next to the Input Panel button and then Transcriber.

2. Tap OK to close the explanation screen of Transcriber.

3. Write anywhere on the screen.

For specific instructions, open Transcriber and tap the question mark icon
next to the writing area.

Selecting typed text:

1. Drag the stylus across the text you want to select.

2. Format or edit text by tapping the command on the Edit menu or by
tapping and holding the selected words until the pop-up menu appears.

When you use the input panel, your device anticipates the word you are
typing or writing and displays it above the input panel. When you tap the
displayed word, it is inserted into your text at the insertion point. The more
you use your device, the more words it learns to anticipate.

Note: To change word suggestion options, such as the number of words
suggested at one time, tap , Settings, Personal tab, Input, and then
the Word Completion tab.

Typing with the soft keyboard:

1. Tap the arrow next to the Input Panel button and then Keyboard.

2. Use the stylus to tap the keys on the soft keyboard.

Using Letter Recognizer:

With Letter Recognizer you can write letters using the stylus just as you
would on paper.

1. Tap the arrow next to the Input Panel button and then Letter Recognizer.

2. Write a letter in the box – it will automatically be converted to typed text on
the screen. 

For specific instructions, open Letter Recognizer and tap the question
mark icon next to the writing area.
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Converting writing to text:
� Tap Tools and then Recognize.

If you want to convert only certain words, select them before tapping
Recognize on the Tools menu (or tap and hold the selected words and
then tap Recognize on the pop-up menu). If a word is not recognized, it is
left as writing.

Writing on the Screen

To write on the screen, write the same way do on paper. The text can be edited,
formatted or converted at a later time.

Writing on the screen:
� To switch to the writing mode, tap the Pen button. Lines will appear

on the screen to help you write.

Note: Not all programs that accept writing feature the Pen button. Refer
to that program’s documentation to find out how to switch to writing. 
If you accidentally write on the screen, tap Edit, then Undo and try again. 

To select writing: 

If you want to edit or format writing, you must select it first.

1. Tap the Pen button to cancel the writing mode.

2. Drag the stylus across the text you want to select.

You can cut, copy, and paste written text in the same way you work with
typed text: tap and hold the selected words and then tap an editing
command on the pop-up menu, or tap the command on the Edit menu.

Section 2: Understanding Your Device
2A: Your Device - The Basics 37

Section 2: Understanding Your Device
36 2A: Your Device - The Basics

SPRINT~1-S2Aa.QXD  02.8.6  5:58 PM  Page 36



Drawing on the Screen

Draw on the screen in the same way that you write on it. The only
difference is how the items are selected and edited. For example, drawings
can be resized - writing cannot.

Creating a drawing:
� A drawing box will appear when you cross any three ruled lines on

your first stroke. Subsequent strokes in or touching the box become
part of the drawing. Drawings that do not cross three lines will be
considered writing. 

Note: You may want to change the zoom level so that you can more
easily work on or view your drawing. Tap Tools and then a zoom level.

Selecting a drawing:

If you want to edit or format a drawing, you must select it first.
� Tap and hold the stylus on the drawing until the selection handle

appears. To select multiple drawings, deselect the Pen button and
then drag to select the drawings you want.

You can cut, copy, and paste selected drawings by tapping and holding the
selected drawing and then tapping an editing command on the pop-up
menu, or by tapping the command on the Edit menu. To resize a drawing,
make sure the Pen button is not selected, and drag a selection handle.

If the word conversion is incorrect, you can select an alternative word by
tapping and holding down on the wrong word. On the pop-up menu tap
Alternates and browse the list. Either tap the word you want to use, or tap
the writing at the top of the menu to return to the original writing.

For best recognition:
� Write neatly within the lines and draw descenders below the line.

Write the cross of the “t” and apostrophes below the top line so they
aren’t confused with the word above. Write periods and commas
above the line.

� Using the Tools menu, increase the zoom level to 300%.
� Write the letters of words close together and leave big gaps between

words.
� Any changes made to a word after you attempt to recognize it (such

as changing a “3” to an “8”) will not be included if you attempt to
recognize it again.

Note: Hyphenated words, foreign words that use special characters
such as accents, and some punctuation cannot be converted.
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Using My Text

My Text quickly inserts preset and frequently used messages into the text
entry areas of Inbox or MSN® Messenger. To insert a message, tap My Text
and select a message.

Note: You can add text after inserting a My Text message.

To edit a My Text Message, tap Edit My Text Messages in the Tools menu.
Select the message you wish to edit and make the changes. Tap OK in the
upper right corner to complete the change.

Recording a Message

A message can also be recorded on any program where you can write or
draw on screen. In Calendar, tasks and Contacts, you can include a
recording in the Notes tab. In the Notes program, you can either create a
stand-alone recording or include a recording with a written note. With the
Inbox program a recording can be added to an email.

When recording or playing a message during data communication, hold
the device keeping distance from your body as shown on page 60.

Creating a recording: 

1. Hold the device’s microphone near your mouth or sound source.

2. Press and hold the Record button (on the left side) until it beeps.

3. While holding down the button make the recording.

4. Release the button to stop recording and two beeps will sound. The new
recording appears in the note list or as an embedded icon.

Note: Tapping the Record button on the Recording toolbar can also
make a recording. To end recording, tap the Stop button.

To play a recording, tap it in the list or tap its icon in the note.

� Tap to show or hide the Recording toolbar. 
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Finding and Organizing Information
To quickly locate information using the Find feature, tap Find in the 
menu.

Note: To quickly find information that is taking up storage space on your
device, select Larger than 64 KB in Type.

File Explorer can also find files on your device and organize them into
folders. To access from the menu, tap Programs, then File Explorer.

� Tap to change folders.
� Tap the folder name to open it.
� Tap Open or to display the path entry screen for opening the shared

file of the network.
� Tap to display the contents of the My Device.
� Tap to display the contents of the Storage card.

Note: To move files in File Explorer, tap and hold the item you want to
move then tap Cut or Copy. Go to the file where you want to move the
document and tap Paste on the pop-up menu.
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Customizing Your Device
Customize your device by adjusting the settings and installing additional
software.

Adjusting Settings

Settings can be adjusted by tapping , Settings, and then the Personal
or System tab located at the bottom of the screen. The following settings
can be adjusted:
� Clock: To change the time or to set alarms.
� Menus: To customize what appears on the menu,

and to enable a pop-up menu from the New
button.

� Owner Information: To enter your contact information.
� Today: To customize the look and the information that

is displayed on the Today screen.
� Buttons: To assign your favorite program to the program

button.
� Remove Programs: See the following pages.
� Password: To limit access to your device. See the following

pages.
� Front Light: See the following pages.
� Power: To maximize battery life. See the following

pages.
� Memory: See the following pages.
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Adding or Removing Programs

Programs installed on your device at the factory are stored on ROM (read-
only memory) and cannot be removed or accidentally lost. ROM
programs can be updated using special installation programs with a *.xip
extension. Any programs and files added after factory installation are
stored in RAM (random access memory). As long as you have enough
memory, you can install any program created for your device. To find
software for your device, visit the Pocket PC website at
http://www.microsoft.com/mobile/pocketpc.

Note: If you update ROM programs using special installation programs
with a *.xip extension, do not use the backup data which you made
before updating ROM programs.

Adding programs using ActiveSync®:

Before installing a program on your device, the appropriate software will
need to be installed on the computer.

1. Determine which version of the software to install by tapping , then
Settings. On the System tab, tap About. In the Version tab, make a
note of the information in Processor. 

2. Download the program to your computer (Or insert the CD or disk that
contains the program into your computer). You may see a single *.xip,
*.exe, or *.zip file, a Setup.exe file, or several versions of files for
different Pocket PC types and processors. Be sure to select the program
designed for the Pocket PC and your device processor type.

3. Read any installation instructions, Read Me files, or documentation
that comes with the program. Many programs provide special
installation instructions.

4. Connect your device and your computer.

5. Double-click the *.exe file.
� If the file is an installer, the installation wizard will begin. Follow the

directions on the screen. Once the software has been installed on your
computer, the installer will automatically transfer the software to your
device. 
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� If the file is not an installer, an error message will appear stating that
the program is valid but designed for a different computer. You will
need to move this file to your device. If you cannot find any installation
instructions for the program in the Read Me file or documentation, use
ActiveSync® Explore to copy the program file to the Program Files
folder on your device. For more information on copying files using
ActiveSync®, see ActiveSync® Help. 

Once installation is complete, tap , Programs, and then the program
icon.

Adding a program directly from the Internet:

1. Determine which version of the software to install by tapping , then
Settings. On the System tab, tap About. In the Version tab, make a
note of the information in Processor. 

2. Download the program to your device straight from the Internet using
Pocket Internet Explorer. You may see a single *.xip, *.exe or *.zip file,
a Setup.exe file, or several versions of files for different device types and
processors. Be sure to select the program designed for the Pocket PC and
your device processor type.

3. Read any installation instructions, Read Me files, or documentation
that comes with the program. Many programs provide special
installation instructions.

4. Tap the file, such as a *.xip or *.exe file. The installation wizard will
begin. Follow the directions on the screen.
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Adding a program to the Start menu:

Tap , Settings, Menus, the Start Menu tab, then the check box for the
program. If you do not see the program listed, you can either use File
Explorer on the device to create a shortcut the program to the Start Menu
folder or use ActiveSync® on your computer to create a shortcut to the
program and place the shortcut in the Start Menu folder.
� Using File Explorer on the device: Tap , Programs, File Explorer,

and locate the program (tap the folder list, labeled My Documents by
default, then My Device to see a list of all folders on the device). Tap
and hold the program and tap Copy on the pop-up menu. Open the
Start Menu folder located in the Windows folder, tap and hold a blank
area of the screen, and tap Paste Shortcut on the pop-up menu. 

The program will now appear on the menu. For more information
on using File Explorer, see “Finding and Organizing Information,” on
page 42.

� Using ActiveSync® on your computer: Use the Explorer in ActiveSync®

to explore your device files and locate the program. Right-click the
program, then click Create Shortcut. Move the shortcut to the Start
Menu folder in the Windows folder. The shortcut now appears on the

menu. For more information, see ActiveSync® Help.

Removing programs:

� Tap , then Settings. On the System tab, tap Remove Programs.

If the program does not appear in the list of installed programs, use File
Explorer on your device to locate the program, tap and hold the program,
and then tap Delete on the pop-up menu.
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Setting Password

Protect data and settings by choosing a password that will be requested
every time the power is turned on.

1. Tap , then Settings. On the Personal tab, tap Password.

2. Select the type of password you would like to use.

� When a strong alphanumeric password is selected, your password must
be at least seven characters long and contain a combination of
uppercase letters, lowercase letters, numerals or punctuation.

� Select how long your device must be turned off before the password is
required to use your device.

3. Enter a password and tap OK.

4. Tap YES on the confirmation screen. The password is saved and the
screen returns to the Personal tab screen.

Note: Record your password in a safe place. If you wish to change your
password, you will have to know the existing one to access the
Password setting screen. If you forget your password, you will have to
initialize the device, which deletes all stored data and settings. 

Note: Once a password is set, you will not be able to place or answer
calls, including 911 emergency calls without first entering your lock code
and unlocking the device.
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Note: You can automatically receive a call when the Auto-Answer is
activated. However, you cannot disconnect without entering the
password.

Setting the Front Light

1. Tap , then Settings. On the System tab, tap Front Light.

2. Set the Front Light.

� Set the time that elapses until the front light automatically turns off if
the device is not used.

3. When finished, tap OK.

Note: If the remaining battery power decreases, the brightness level
may be lower than the selected setting.
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Setting Power

To confirm and control power usage:

1. Tap , then Settings. On the System tab, tap Power.

2. Set Power Options. 

� When the AC Adapter is used, the battery charging mode is displayed,
but the remaining battery power is not displayed.

� Set the time that elapses until the power automatically turns off if the
device is not used.

3. When finished, tap OK.
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Setting Memory

Memory for the device is automatically managed. You can adjust data
storage memory and program running memory, and confirm the amount
of free space on a storage card.

Changing memory allocation:

1. Tap , then Settings. On the System tab, tap Memory to display the
Memory setting screen.

2. Drag the slider widthwise to adjust the memory allocation between
Storage and Program.

3. When finished, tap OK.
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To confirm usage status of a storage card:

1. Tap , then Settings. On the System tab, tap Memory, then the
Storage Card tab on the bottom.

2. When finished, tap OK.

Releasing memory:

If memory is approaching full capacity, you can free up space by:
� Transferring data to a storage card or to your computer then delete it

from your device.
� Deleting unnecessary files and programs.
� Quitting the program currently in use.

Note: For more detailed information on operation method or the
releasing memory, tap then Help.
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Section 2B

Phone Function: The Basics

In This Section

� Viewing the Display Screen

� Turning the Phone Function ON and OFF

� Talking on the Device

� Displaying Your Phone Number

� Making and Answering Calls

� KeyGuard Lock

� Scratch Pad

Your device is packed with features that simplify your life and expand your
ability to stay connected to the people and information that are important

to you. This section will guide you through the basics of phone function and
you’ll be on your way to using it in no time.

This device’s phone component can be used with the Phone Headset/Remote
Control Unit or as a speakerphone. Unlike conventional cell phones, it is not
designed to be held against the head in conversation. Such use of the phone is
contrary to the design of the product and is strongly recommended against.
Please use the device with the Phone Headset/Remote Control Unit or in
speakerphone mode. For instructions on how to use the phone with the Phone
Headset/Remote Control Unit or as a speakerphone, please refer to page 60 of
this guide.
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Icons

Icons of the display indication
Icon Meaning

Auto-Answer incoming Voice Calls

Unread message waiting

One or more voicemail messages

One or more missed calls

Headset connected to the device

When receiving a call, the ringer tone sounds and the
vibrating alert vibrates simultaneously.

When receiving a call, the ringer tone does not sound
but the vibrating alert vibrates.

When receiving a call, the ringer tone does not sound
and the vibrating alert does not vibrate.

Mutes during a call.

Enhanced Voice Privacy is available during a call.

PCS Vision is not available here.

Roaming

Icons of the modem
Icon Meaning

Modem is currently unusable.

Data transfer

Voice call
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Viewing the Display Screen
Main Screen

VOICE tab

DATA tab
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Coverage Indicator Icons

Connection Drop-List

Shortcut to Dial-up Manager

In Use Indicator

Status box displays information about the  
current call and any status messages.

Indicator Icons

Data/Voice Controls Tab Selection

Phone number of the connection 
destination

Admin menu

Scratch Pad

Contacts

Receiving Signal 
Strength Indicator

Keypad

BACK Button

Tools menu

END Button

TALK Button

Speaker Icon Button

Volume Buttons
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Navigation Button and Program

When in the phone function’s screen, pressing the navigation button on
the device opens the following programs:

Top : Contacts

Bottom : Messaging

Right : Call Log

Left : Speed Dial
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Keypad Operation List

Regardless of the program in use, pressing the button or the 
button while phone function is open displays the VOICE tab of the phone
function’s screen.

Even if the power is turned off, pressing the  button turns the power
on and displays the VOICE tab screen. (However, the setting can be
changed not to turn the power on.)

When the phone function’s screen is displayed, the / buttons
on the device perform the same functions as the / buttons on
the screen. Button functions include:

Idle Incoming Call During a Voice Call

0-9, 
*, #

BACK
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Speed Dial

Contacts

Messaging

Call Log

Calls phone number
displayed on screen. If
a phone number is not
displayed, last number
dialed is called.
Delete all entered
numbers at once.

Delete entered
numbers one by one or
tap and hold 
button to delete them
all at one time.
Enter the number you
wish to call. Tap and
hold the Speed Dial
location number for
one-touch dialing of
that number.

BACK

Answer a
call.

Reject the
incoming
call.
Mute the
ringer tone.

If Any-key
Answer is
set, you can
answer a
call by
tapping any
of these
keys.

Answers incoming call;
switches to Three-Way
calling.

End all calls including
the three-way calling.

Delete messages or
entered numbers one by
one. Tap and hold the

button to delete
them all at one time.
Number entered is
displayed on screen.

BACK
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Turning the Phone Function ON and OFF
Turning The Phone Function ON

When the Radio Standby Switch is ON and the phone function is
launched, the phone function’s screen automatically is displayed when a
call is received, even if you are currently using another program.

1. Turn the Radio Standby Switch (located on the left side) ON. The phone
function (PCS Connection) will automatically launch and the device
can be used when the main screen appears.

Note: When launched, a phone function status icon is displayed on the
right part of the Today screen command bar. 
As long as the Radio Standby Switch is ON, the phone function screen
will automatically appear when a call is received, even if the display
screen is off.

Note: This device is operated by the Pocket PC operating system and the
application programs on the device, pre-loaded and post-loaded. If the
system get in such unusual case as when a button or tapping the screen
does not respond, the phone functions are also unavailable, voice or
data, outgoing or incoming. In such a case, please reset your device.
See “Resetting” on page 144.

Turning The Phone Function OFF

1. Turn the Radio Standby Switch OFF. the phone function will turn off
and the phone function’s screen will disappear.
Do not quit phone function during a call or communication.

Note: When the Radio Standby Switch is OFF, the phone function will not
work even if the device is on.

Note: If you turn the Radio Standby Switch OFF while the device is OFF,
the device will turn on automatically, and then the phone function will
turn off.
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Tools menu:

The following items can be selected from the Tools menu of the DATA and
VOICE tabs:

Admin menu:

The following items can be selected from the Admin menu of the DATA
and VOICE tabs:

Displays information about 
the phone function.

Use this when the phone 
functions of device are not 
activated.

Displays the Messaging screen.

Displays the Connections setting 
screen.

Displays screen for storing numbers.

Displays a list of incoming calls, 
outgoing calls, missed calls.

Protects against accidental 
operation. 
Displays Options for changing 
settings.

Displays Contacts.
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Talking on the Device
Here explains how to use your device when you talk on the phone. Keep the
device from your face more than 1 inch (2.5 cm).

Using the Microphone and Speaker:

Using the Phone Headset:

To use the supplied Phone Headset, insert it into the headset jack.

For the Phone Headset, see page 20.

Using the Remote Control Unit:

To use the Remote Control Unit, insert it into the headset jack and insert
the headphones (sold separately) into the stereo headphones jack of the
Remote Control Unit.

For the Remote Control Unit, see page 21.

To use the  / button of the Remote Control Unit, press and
immediately release for and press and hold for . 
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Displaying Your Phone Number
Just in case you forget your phone number, your PCS Device can 
remind you.

To display your phone number:

1. Tap Admin.

2. Tap About.

Making and Answering Calls
Making Calls

Your PCS Device offers many different ways to make calls, including 
PCS Voice CommandSM (page 163), using Contacts (page 90), Speed
Dialing (page 94) and using Call History (page 82).

To make a call using your keypad:

1. Turn the Radio Standby Switch (located on the left side) ON. The phone
function will automatically launch and the phone function can be
used when the main screen appears.

2. On the VOICE tab screen, enter a phone number. (If you make a
mistake while dialing, tap to erase one digit at a time. Tap 
to erase the entire number. Tapping and holding also erases the
entire number.)

3. Tap .

4. When you’re finished, Tap .

Tip: To redial your last outgoing call, tap on the VOICE tab screen.
The redial function does not work when there has been a missed call.

Tip: When making calls off the enhanced Sprint Nationwide PCS
Network, always dial using 11 digits (1 + area code + phone number).

BACK

BACK

SPRINT2B.QXD  02.8.6  6:43 PM  Page 60



Answering Calls

1. Make sure the phone function is on.

2. When a call comes in, answer the call by tapping . Depending on
your settings, your PCS Device notifies you of incoming calls in the
following ways:

� The device rings or vibrates.
� The LED flashes.
� The screen displays an incoming call message.
� If available, the phone number of the caller is displayed.
� If the phone number is in the Pocket Outlook® Contacts list, the list

entry’s name is displayed.

Tapping or the Volume  button can mute the ringer tone.

Note: If the phone function is off, incoming calls go to voicemail.

3. To disconnect the call, tap .

Note: When is tapped during an incoming call, it is rejected and
the missed call icon appears.

About Any-key Answer:
� When activated, Any-key Answer enables calls to be answered by

tapping any button, other than the , or Volume buttons.
This also includes the four program buttons on the front of the device.

� To set, in the VOICE tab screen, tap Tools, Options, and then Voice at
the bottom of the screen. For more information, see page 70. 

About Caller ID:

If a call is received from a number stored in the Pocket Outlook® Contacts
list, the name and number will be displayed. “Unknown” will be displayed
if the caller is not on the Contacts list.

BACK

BACK

Section 2: Understanding Your Device
2B: Phone Function - The Basics 63

Section 2: Understanding Your Device
62 2B: Phone Function - The Basics

Volume Control
Adjust the ringer volume by using the Speaker Icon on the navigation
bar. And adjust the call volume by using the Volume buttons.

Speaker Icon button:

The ringer type changes each time you tap the Speaker Icon button .

The setting options in standby mode are “Ringer Only,” “Ring and Vibrate,”
“Vibrate Only,” and “Ring and Vibrate Off”.

During a call, the setting switches between “Sound on” and “Mute”.

Volume buttons:

When you tap the Volume buttons , a volume bar appears on the
screen to indicate the call volume level (6 levels excluding Mute).

The call volume can be adjusted by tapping Tools, then Options, then
Sounds at the bottom of the screen.

Speaker Icon button

Speaker Icon

Volume buttons
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Missed Call Notification

When an incoming call is not answered, the Missed Call icon and the
missed call message are displayed on your screen.

Tap to turn off the missed call message.

Returning Missed Calls

To return the last missed call, tap . When is tapped, the Call Log
appears. This can be used to select a contact to call back. For details on the
Call Log function, see page 81.

Note: If the caller’s number is not identified, you cannot call back.

Calling Emergency Numbers

You can place calls to 911 (dial and tap ), even if
the phone function is locked or your account is restricted, or key Guard is
activated.

Note: When a password is set, if you do not enter the password when
you turn on the power, you can not place phone calls.

Note: If an emergency number is stored in Speed Dial you will be able to
dial it by tapping a single key. However, speed dial will not work if
KeyGuard is enabled.

119
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KeyGuard Lock
This function guards against accidentally inputting numbers or tapping
unwanted keys. To enable from the VOICE tab screen:

1. Tap Tools, then KeyGuard. “KeyGuard enabled” appears on the screen. 

2. Repeat the same process to turn KeyGuard off.

Note: When KeyGuard is enabled, the only functions that can be
performed are selecting the Tools/Admin menus, placing emergency
calls, receiving incoming calls (by tapping ), and turning the
KeyGuard mode off.

Scratch Pad
The Scratch Pad allows you to take notes while on the phone. To access,
tap . 

� Tap OK to close Scratch pad. Contents will remain even when device is
shut down.

� Tap Clear to delete all notes.
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Section 2C

Controlling the Phone
Function’s Settings

In This Section

� Sounds Settings

� Security Settings

� Voice Settings

� Massaging Settings

� General Settings

� Display Settings

This section describes how you can change the phone function settings to
best suit your requirements. Take a few moments to review these options

and add or adjust the settings that are right for you.
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Security Settings
Tap Options on the Tools menu, then tap Security.

When the modem is locked, most menu functions (Options, Messaging,
Call Log etc.) cannot be used. (The Unlock Modem menu can be
selected.)

Also, no calls other than emergency calls can be placed, and when a call is
received, the caller’s phone number is displayed “***”.

The default of the lock code is the last four digits of the device’s phone
number, if the phone function is activated.

� Select never or on power up.
� Tap Change Lock Cord to change the lock code. To change the lock

code, first enter the old lock code, then enter the new one.
� Tap Lock Modem Now to immediately lock the modem.
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Sounds Settings
Use to select the sounds for incoming calls, voicemail and messages.

Tap Options on the Tools menu, then tap Sounds.

� Tap “>” to play selected sound.
� Tap “...” to select a sound file.
� Select a receiving type from “Ringer Only”, “Ring and Vibe”, “Vibrate

Only” and “Ring and Vibe Off” in the “Incoming Call” section.

You can also select a receiving type with the Speaker Icon button on the
VOICE tab screen.

� You can Adjust the volume of the conversation by drugging Headset
Volume slider. The volume can also be changed at the VOICE tab.

� Tap Cancel to return to the previous screen without storing the settings.
� Tap Restore to restore all the settings to the defaults.
� Tap Save to save the new settings.

The operations for Cancel, Restore and Save are common for each tab
screen.
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Messaging Settings
Sets options for short message services.

Tap Options on the Tools menu, then tap SMS.

� Sets messages expiration dates.

General Settings
Tap Options on the Tools menu,the tap General.

� Sets number of minutes a line is disconnected after data
communication ends in the “Data-Call Inactivity Timeout :
Disconnect” section.
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Voice Settings
Tap Options on the Tools menu, then tap Voice.

� Determines when auto-answer function answers phone in the “Auto-
Answer” section. Ideal to use while driving.

� Determines when to retry a call that did not connect in the “Auto-
Retry” section.

� When Auto-Hyphenation is checked, automatically adds hyphenation
when phone numbers are entered on keypad.

� When Any-key Answer is checked, incoming calls can be answered by
pressing any key other than , and the Volume button. This
function is enabled even in the Key Guard mode.

� Sets the keypad tone length in the“DTMF Configuration” section.
� When Mute is checked, tone is not sounded.
� When Minute Alert is checked, tone sounds every minute during phone

calls.
� When Service Alert is checked, a tone is sounded when calls are

interrupted, when the service area switches from home to roaming, etc.
� Tap Change in the “VoiceMail” section to set the number for checking

your voicemail.

BACK
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(Display tab of Options can be set to display warning before line is
disconnected.)

� Select the number of calls to be retained in the Call Log in the“Call
Logging Retain” section. Calls exceeding this number are
automatically deleted.

� System selection is possible in an area that permits roaming in the
“System Select” section.

Home Only: Permits only home service.

Home Preferred: Permits roaming if the home service is not found.

See “Setting Your Device’s Roam Mode” on page 79.
� When Update System Clock with CDMA time during start-up is

checked, CDMA network updates the time when PCS Connection is
launched.

� When connecting teletypewriter, etc. to the headset jack, select On (Full)
in the “TTY Mode” section.

Display Settings
Tap Options on the Tools menu, then tap Display.

� When Data connection lost is checked, PCS Connection automatically
comes in front when a data connection is unexpectedly lost.

� For more information about Call Guard see “Controlling Roaming
Charges Using Call Guard” on page 79.
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Section 2D

Setting Your Device’s Security

In This Section

� Locking Your Device

� Locking the Phone Function

� Unlocking the Phone Function

� Changing the Lock Code

� Calling in Lock Mode

By using the security setting on your PCS Device, you receive peace of mind
without sacrificing flexibility. With several options available, you can

customize your device to meet your personal needs.
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Calling in Lock Mode
You can place calls to 911 and to your special numbers when in lock mode.

To place an outgoing call in lock mode:
� To call an emergency number, special number or PCS Customer

Solutions, enter the phone number and tap .
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Locking Your Device
See “Setting Password” on page 47.

Locking the Phone Function
When the phone function is locked, you can only receive incoming calls
or make calls to 911, PCS Customer Solutions or special numbers.

To lock the phone function:

1. Tap Options on the Tools menu, then tap Security.

2. Tap Lock Modem Now.
� Refer to “Security Settings” on page 69.

Tip: If you can’t recall your lock code, try using the last four digits of
either your Social Security number or PCS Phone Number or try 0000. If
none of these work, call PCS Customer Solutions at 1-888-211-4PCS (4727).

Unlocking the Phone Function
To unlock the phone Function:

1. Tap Unlock Modem on the Tools menu.

2. Enter your lock code.

Changing the Lock Code
To change your lock code:

1. Tap Options on the Tools menu, then tap Security.

2. Tap Change Lock Code.

3. Enter your lock code.

4. Enter your new lock code.

5. Re-enter your new lock code.
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Section 2E

Controlling Your Roaming
Experience

In This Section

� Understanding Roaming

� Setting Your Device’s Roam Mode

� Controlling Roaming Charges Using Call Guard

Roaming is the ability to make or receive calls while you’re off the 
Sprint Nationwide PCS Network. Your new dual band PCS Device works

anywhere on the enhanced Sprint Nationwide PCS Network and allows you to
roam on digital networks virtually anywhere in the U.S. where compatible
wireless service is available. 

This section explains how roaming works as well as special features that let
you manage your roaming experience. 
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Note: If you’re on a call when you leave the Sprint Nationwide 
PCS Network and enter an area where roaming is available (whether
digital or analog), your call is dropped. If your call is dropped in an area
where you think PCS Service is available, turn the phone function off and
on again to reconnect to the Sprint Nationwide PCS Network.

Setting Your Device’s Roam Mode
Your PCS Device allows you to control your ability to roam. By using the
Roaming menu option, you can determine which signals your device
accepts.

Set Mode

Choose from two different settings on your device to control your roaming
experience:

1. Tap Options on the Tools menu.

2. Tap General tab.

3. To select an option, tap in the “System Select” section.
� Home Only: This setting allows you to select the enhanced Sprint

Nationwide PCS Network only and prevents roaming on other networks.
� Home Preferred: This setting seeks PCS Service. When PCS Service is

unavailable, the device searches for an alternative system.

Controlling Roaming Charges Using Call Guard
In addition to the roaming icon, Call Guard alerts you when roaming
charges apply. This feature makes it easy to manage your roaming
charges by reminding you when you make or receive roaming calls.

To Turn the Call Guard Feature On or Off:

1. Tap Options on the Tools menu.

2. Tap Display tab.

3. Check Call Guard to turn the Call Guard on. To turn the Call Guard off,
clear the checkbox.
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Understanding Roaming
Recognizing Icons on the Display Screen

The phone function’s display screen always lets you know when you’re off
the Sprint Nationwide PCS Network. The following chart indicates what
you’ll see depending on where you’re using your device.

Roaming 
Indicator

Sprint Nationwide PCS Network

Other Digital Networks

Tip: Remember, when you are using your device off the Sprint
Nationwide PCS Network, always dial numbers using 11 digits 
(1 + area code + number).

Note: You will pay a higher per-minute rate for roaming calls.

Roaming on Other Digital Networks

When you’re roaming on other digital networks, your call quality and
security will be similar to the quality you receive when making calls while
on the enhanced Sprint Nationwide PCS Network. You may not be able to
access certain calling features, such as PCS Vision.
� Some calling features which are standard on the enhanced Sprint

Nationwide PCS Network, such as call waiting, PCS Vision Products and
Services and direct international dialing, are unavailable.

� Though callers can leave voicemail messages while you are roaming,
you will not receive notification until you return to the Sprint
Nationwide PCS Network. While roaming, you can periodically check
your voicemail for new messages by dialing 1+area code+your PCS
Phone Number. Tap when you hear your greeting and enter your
pass code at the prompt.

� There are security and privacy risks (eavesdropping and cloning) that
exist with conventional analog services today.
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To Place Roaming Calls With Call Guard On:

1. Place a call.

2. Tap Continue when the message screen appears.

To Answer Incoming Roaming Calls With Call Guard On:

� Tap Continue in the message screen.
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Section 2F

Managing Call History

In This Section

� Viewing History

� Making a Call From Call History

� Saving a Phone Number From Call History

� Storing Call Log As a Text File

The Call History helps you manage your time more effectively. It keeps 
track of incoming calls, calls made from your PCS Device and missed

calls. This section guides you through accessing and making the most of your 
Call History.
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Saving a Phone Number From Call History
You can keep telephone numbers in “Contacts” in Microsoft® Pocket
Outlook®.

To save a phone number from Call History:

1. Tap and hold the number you want to save.

2. When the pop-up menu appears, tap Add to New Contact or Add to
Existing Contact. The Edit menu for Contacts is displayed.

� To save the contact of a person who is already registered, tap Add to
Existing Contact.

3. If you tapped on Add to New Contact, enter the name.

4. Select the number as which it is to be added. 

5. Tap save.

For details on adding contacts, see “Contacts: Tracking Friends and
Colleagues” on page 90.

Note: You cannot save phone numbers from calls identified as No ID or
Restricted.

Storing Call Log As a Text File
1. Tap Save As on the File menu.

2. Name the text file on the Save As screen. 

3. Tap OK.
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Viewing History 
Call Log screen displays a list of incoming, outgoing and missed calls,
including caller information and call time. To display, tap Call Log on the
Tools menu or press right on the navigation button. 

When you tap and hold a log entry a pop-up menu displaying Dial,
Delete, Add to New Contact, Add to Existing Contact and Copy Phone
Number.

Making a Call From Call History
To place a call from Call History:

1. Tap and hold the number you want to place a call.

2. When the pop-up menu appears, tap Dial.

Note: You cannot make calls from Call History to entries identified as 
No ID or Restricted. 
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Section 2G

Microsoft® ActiveSync®

In This Section

� Using Microsoft® ActiveSync®

By connecting your device to your computer using ActiveSync®, your data
will be synchronized and transmitted. This section explains how to install

ActiveSync® to your computer and the procedure for connecting your device
and your computer. 
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2. Click "Start Here".

3. Install Outlook® 2000.
� Click “Install Outlook 2000” and follow the instructions on the screen.

4. Install ActiveSync® 3.5.
� Click “Install ActiveSync 3.5” and follow the instructions on the screen.
� When installation is completed, a connection wizard appears.

5. When the "Get Connected" screen appears, connect the USB cradle to
the USB port of your computer.

� At this time, do not insert your device into the USB cradle.

6. Connect your device to the USB cradle with your device power turned off.

� Insert your device firmly.

7. Proceed with the setting according to the instructions on the screen.

Note: For more information on the connection to your device or other
settings, please see the Help option in ActiveSync®.

USB port
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Using Microsoft® ActiveSync®

Microsoft® ActiveSync® synchronizes the information on your computer
with the information on your device. Synchronization compares data
between the two and updates both with the most recent information. For
example:
� Keep Pocket Outlook® data up-to-date by synchronizing your device

with your computer’s Microsoft® Outlook®.
� Synchronize Microsoft® Word and Microsoft® Excel files between the

two. Files will be automatically converted to the correct format.

Note: Use ActiveSync® options to select which types of information to be
synchronized.

With ActiveSync®, you can also:
� Back up and restore your device data. 
� Copy (rather than synchronize) files between your device and

computer. 
� Control when synchronization occurs by selecting a synchronization

mode. For example, you can synchronize continually while connected
to your computer or only when you choose the synchronize command.

� Select which information types are synchronized and control how
much data is synchronized. For example, you can choose how many
weeks of past appointments you want synchronized.

Before you begin synchronization, install ActiveSync® on your computer
from the Companion CD. ActiveSync® is already installed on your device.

Connection to Your Computer

Install ActiveSync® on your computer the first time you connect it to your
device.

1. Insert Companion CD into CD-ROM drive of the computer.

The screen showing the startup of a setup program is displayed.
� If a setup program does not start up even after insertion of the CD-ROM,

double click SETUP. EXE in the route directory contained on the CD-
ROM.
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After this initial synchronization, view your device’s Calendar, Contacts
and Tasks. Everything stored in Microsoft® Outlook® on your computer
should now be on your device. Disconnect the device from your computer
and you’re ready to go.

To initiate ActiveSync® on your device, tap , and then tap ActiveSync.

For information about using ActiveSync® on your computer, see
ActiveSync® Help in the ActiveSync® program.

� Tap to connect and synchronize.
� Tap to stop synchronization.
� Tap Tools to synchronize via IR or change synchronization settings.

For more information about ActiveSync® on your device, switch to
ActiveSync® , tap , then tap Help.
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Section 2H

Using the Microsoft® Pocket
Outlook®

In This Section

� Contacts: Tracking Friends and Colleagues

� Calendar: Scheduling Appointments and Meetings

� Tasks: Keeping a To Do List

� Notes: Capturing Thoughts and Ideas

� Inbox: Sending and Receiving Email Messages

� Managing Email Messages and Folders

If the contact data is in Microsoft Outlook on your personal computer, the
Microsoft Pocket Outlook application on this device can read the contact

data. This section explains how to use Microsoft Pocket Outlook.

Microsoft® Pocket Outlook® includes Calendars, Contacts, Tasks, Inbox and
Notes which can be used individually or together. For example, email
addresses stored in Contacts can be used to address email messages in Inbox. 
ActiveSync® synchronizes information in Microsoft® Outlook® or Microsoft®

Exchange on your computer with your device, comparing changes made on
both and updating each of them with the latest information. For
information on using ActiveSync®, see ActiveSync® Help on the computer.
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Creating a Contact

1. Tap New.

� Tap OK to return to the contact list (the contact is saved automatically).
� Notes is a good place for maps and directions.

2. Enter name and contact information. Scroll down to see all available
fields.

3. Tap Categories to assign the contact to a category. In the list, Contacts
can be displayed by category.

4. Tap the Notes tab to add notes or a drawing, or to create a recording.
For more information, see “Notes: Capturing Thoughts and Ideas”
later in this chapter.

5. Tap OK when finished.

Note: If you want to add a phone number that should always be dialed as long
distance call, put +1 as number prefix.
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Contacts: Tracking Friends and Colleagues
Contacts maintains an easily accessible list of friends and colleagues (See
note). The device’s infrared (IR) port allows you to quickly share Contacts
information with other device users. To access Contacts, tap , then
Contacts. Or, press the Contacts Program button on the front of the device.

You can also access Contacts with the following method from the phone
function’s screen. 
� Tap on the VOICE tab screen.   
� Pressing “Up” on the navigation button.

� Tap All Contacts to select the category of contacts you want displayed
in the list.

� Tap the search box and enter part of a name to quickly find it in the list.   
� Tap to the right an entry to see additional phone numbers and email

addresses.
� Tap on an entry to display or edit the contact details.
� Tap and hold to display a pop-up menu of actions.

Note: Tap Tools then Options to change the way information is displayed.

Note: When transferring the contact to another device by using infrared (IR), tap
and hold that contact, then tap the Beam Contact from the displayed pop-up
menu. For more information, See “Transferring Items Using Infrared” on page128.
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Making a Call From Contacts

1. Turn the Radio Standby Switch ON.

2. Open Contacts.

3. Tap and hold a contact.

4. Tap Dial Contact on the pop-up menu.

5. Tap the number you want to dial.

Link Dialing

With Link Dialing you can place calls require multiple inputs in a
sequence of continuous operations.

Link Dialing Storing

1. From the Today screen tap New then Contact.

2. Enter the phone number.

3. After the phone number, enter uppercase “L” or lowercase “l”, then the
next number.

4. To enter more numbers repeat step 3.

5. Once all the numbers are entered, tap OK.

Example: 604-323-**** L 9837*** l 9832**
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Finding a Contact

There are four ways to find a contact from the contact list:
� Enter a name in the box under the navigation bar. To view all contacts,

clear text from the box or tap the button to the right of the box.
� Tap the category list (labeled All Contacts by default) and select the

type of contact you want displayed. To view unassigned contacts, select
No Categories. Select All Contacts to view the entire contacts list.

� To view contacts by their company names, tap View, then By
Company. The number of contacts working for that company will be
displayed to the right of the company name.

� Tap , Find, enter the contact name, select Contacts for the type,
then tap Go.

Using the Summary Screen

Tap a contact to display the summary screen. To make changes, tap Edit.
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Clearing

1. On the phone function’s screen, tap Speed Dial on the Tools menu or
press left on the navigation button. The phone number section storing
keypad number appears.

2. Tap and hold the entry you want to clear.

3. When the pop-up menu appears, tap Clear Speed Dial Entry.

“<Unassigned>” appears in the location. 

4. Tap OK.
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Speed Dial

Using speed dial simplifies calling. Turn the Radio Standby Switch on
when using Speed Dial.

Storing

1. Open Contacts.

2. Tap and hold the contact you want to add to the Speed Dial.

3. When the pop-up menu appears, tap Add to Speed Dial.

4. Tap the phone number you want to add to the Speed Dial.

5. Tap the entry number.

� Tap to call to the phone number in the right section.

Dialing

1. Open the phone function’s screen.

2. On the VOICE tab screen, tap and hold the corresponding speed dial
location number of the number you wish to call for at least one second.

Note: Selecting the corresponding speed dial location on the keypad and
then tapping can also place Speed Dial calls.

Note: Voicemail is assigned as number 1.
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Creating an Appointment

If you are in Day or Week view, tap the desired date and time for the
appointment.

1. Tap New.

� Tap to return to the calendar (the appointment is saved automatically).
� Tap in the subject section  to choose from predefined text.
� Tap in the location section to choose from previously entered

locations.
� Tap in the starts section to select a time.
� Tap in the ends section to select a date.
� Notes is a good place for maps and directions.

2. Enter a description and location.

3. Adjust date and time as needed.

4. Enter other desired information. Hide the input panel to view all
available fields.

5. Tap the Notes tab to add notes or a drawing, or to create a recording.
For more information see “Notes: Capturing Thoughts and Ideas” later
in this chapter.

6. Tap OK when finished.
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Calendar: Scheduling Appointments and
Meetings

Use Calendar to schedule appointments, including meetings and other
events. You can check your appointments in one of several views (Agenda,
Day, Week, Month, and Year) and easily switch views by tapping one of the
5 view icons at the bottom of the screen or by pressing the Calendar
Program (button#1 on front of your device).

To access the Calendar, tap , then Calendar. Or, press the Calendar
Program button on the front of the device.

� Tap to go to today
� Tap on the appointment to display or edit the details.
� Tap to switch between the 5 views (Agenda, Day,

Week, Month and Year).

Note: Tap Options on the Tools menu to customize the Calendar display. 
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Tasks: Keeping a To Do List
Tasks keeps track of what has to be done. To access, tap , then Tasks.
Or, press the Tasks Program button on the front of the device.

� Tap All Tasks to select the category of tasks you want displayed in the
list.

� Tap Priority to select the sort order of the list.
� Indicates high priority
� Tap on a task to display or edit the task details.
� Tap and hold to display a pop-up menu of actions.

Note: Tap Tools then Options to change the way information is displayed.
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Note: If you select Remind me in an appointment, your device will remind
you according to the options set in the menu, Settings, Personal tab,
Sounds & Notifications. 

Using the Summary Screen

Tap an appointment to display the summary screen. To make changes,
tap Edit.

Creating Meeting Requests

Calendar can set up meetings with Outlook® or Pocket Outlook® users.
The meeting request will be created automatically and sent either when
you synchronize Inbox or when you connect to your email server. Indicate
how you want meeting requests sent by tapping Tools then Options. If you
send and receive email messages through ActiveSync®, select ActiveSync.

To schedule a meeting:

1. Create an appointment.

2. In the appointment details, hide the input panel, then tap Attendees.

3. Select the meeting attendees from your Contacts list. Tap OK.

The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see
Calendar Help and Inbox Help on the device.
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Using the Summary Screen

Tap a task to display the summary screen. To make changes, tap Edit.

� Tap to show and hide additional summary information.
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Creating a Task

1. Tap New.

� Tap OK to return to the task list (the task is saved automatically).
� Tap in the subject section to choose from predefined subjects.
� Notes is a good place for maps and drawings.

2. Enter a description.

3. Enter a start and due date or other information by tapping the field. To
see all available fields, hide the input panel.

4. Tap Categories to assign the task a category. In the list, Tasks can be
displayed by category.

5. Tap the Notes tab to add notes or a drawing, or to create a recording.
For more information, see “Notes: Capturing Thoughts and Ideas”
later in this chapter.

6. Tap OK when finished.

Note: To quickly create a task with only a subject, tap Entry Bar on the
Tools menu. Then, tap Tap here to add a new task and enter your task
information.
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� Tap OK to return to the note list (the note is saved automatically).
� Tap to show or hide the Recording toolbar.
� Tap the Pen button to write on the screen.
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Notes: Capturing Thoughts and Ideas
Notes quickly captures thoughts, reminders, ideas and phone numbers.
You can also create a recording to include with the entry.

� Tap Name to change the sort order of the list.
� Tap on a note to open the note or to play a recording.
� Tap and hold to display a pop-up menu of actions.
� Tap to record.
� Tap to show or hide the Recording toolbar.

Creating a Note

1. Tap New.

2. Create your note by writing, drawing, typing, and recording. For more
information about using the input panel, writing and drawing on the
screen, and creating recordings, see “Entering Text Using the Input
Panel”on page 33.
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Connecting Directly to an Email Server
Your device can send and receive email messages by connecting to an
email server. For more information about establishing this remote
connection, see page 130.

Once connected to the email server:
� New messages are downloaded to the device Inbox folder, 
� Messages in the device Outbox folder are sent; and
� Deleted messages are removed from the device Inbox folder

Messages received directly from an email server are linked to your email
server rather than your computer. When a message is deleted from your
device, it will also be deleted from the email server the next time you
connect.

When working online connected to your server, you can immediately read
and respond to messages - they are sent as soon as you tap Send, saving
space on your device.

To work offline, download new message headers or partial messages, and
disconnect from the server. You can then mark which messages to
completely download the next time you connect.

Using the Message List
Received messages are displayed in the message list - the most recently
received are listed first.

� Tap Inbox to select the service and folder you want to display.
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Inbox: Sending and Receiving Email
Messages

Use Inbox to send and receive email messages in either of these ways: 
� Synchronize email messages with Microsoft® Exchange or Microsoft®

Outlook® on your computer.
� Send and receive email messages by connecting directly to an email

server through PCS Connection.

Synchronizing Email Messages
Email messages can be synchronized as part of the general
synchronization process. You will need to enable Inbox synchronization
in ActiveSync®. For information on enabling Inbox synchronization, see
ActiveSync® Help on the computer.

During synchronization:
� Messages are copied from the mail folders of Exchange or Outlook® on

your computer to the ActiveSync folder in Inbox on your device. By
default, you will receive messages from the past five days only, the first
100 lines of each message, and those not including file attachments.

� Email messages in the Outbox folder on your device are transferred to
Exchange or Outlook®, and then sent from those programs.

� Email messages in subfolders must be selected in ActiveSync® on your
computer in order to be transferred.
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Composing Messages

1. Tap New. 

2. In the To field, enter the email addresses of the recipients, separating
the names with a semi-colon, or select a name from the contact list by
tapping and holding To, or by tapping the Address Book button.

� Tap to show or hide the complete header.
� Tap to show / hide the recording toolbar.
� Tap to show or hide the Recording toolbar.
� Tap to display the Address Book.

3. Compose your message. To enter preset or frequently used messages,
tap My Text and select a message.

4. Tap Send when you’ve finished the message. If you are working offline,
the message is moved to the Outbox folder and will be sent the next time
you connect.
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� Tap Received Data to select the sort order for messages.
� Tap on a message to open the message.
� Tap and hold to display a pop-up menu of actions.
� Tap to connect to the selected service.
� Tap to connect and to send and receive email.

When you receive a message, tap it to open it. Unread messages are
displayed in bold.

� Tap OK to return to the message list.
� Tap to delete this message.
� Tap to view the previous or next message.
� Tap to reply to or forward this message.

To retrieve a full message during your next synchronization or email
server connection, tap and hold the message. On the pop-up menu tap 
Mark for Download. 

Specify downloading preferences when you set up the service or select your
synchronization options. 
� Inbox synchronization options can be changed using ActiveSync®

options. See ActiveSync® Help for more information.
� To change options for email server connections, tap Tools then tap

Options. On the Services tab, tap the service you want to change. To
remove a service, tap and hold the service and select Delete.
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Managing Email Messages and Folders
Messages are displayed in one of five folders: Inbox, Deleted Items, Drafts,
Outbox and Sent Items. The Deleted Items folder contains messages that
have been deleted on the device. The behavior of the Deleted and Sent
Items folders depends on the options you have chosen. In the message list,
tap Tools then Options. On the Message tab, select your options.

To create new folders, tap Tools then Manage Folders. For all service
except ActiveSync®, you can access folder options by tapping Tools then
Manage Folders. To move a message to another folder, tap and hold the
message and then tap Move to on the pop-up menu.

Folder behavior with a direct connection to an email server

The behavior of the folders you create depends on whether you are using
ActiveSync®, POP3, or IMAP4:
� If you use ActiveSync®, email messages in the Inbox folder in Outlook®

will automatically be synchronized with your device. You can select to
synchronize additional folders by designating them for ActiveSync®.
The folders you create and the messages you move will then be
mirrored on the server. For example, if you move two messages from the
Inbox folder to a folder named Family, and you have designated Family
for synchronization, the server creates a copy of the Family folder and
copies the messages into that folder. You can then read the messages
while away from your computer.

� If you use POP3 and you move email messages to a folder you created,
the link is broken between the messages on the device and their copies
on the mail server. The next time you connect, the mail server will see
that the messages are missing from the device Inbox and delete them
from the server. While this eliminates duplicate copies of messages, you
will no longer have access to messages moved to folders created
anywhere except the device.

� If you use IMAP4, the folders you create and the email messages you
move are mirrored on the server. Therefore, messages are available to
you anytime you connect to your mail server, whether it is from your
device or computer.
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Section 2I

Companion Programs

In This Section

� Pocket Word

� Pocket Excel

� MSN® Messenger

� Windows MediaTM Player for Pocket PC

� Microsoft® Reader

� Pocket Internet Explorer 

This section describes how to use the programs listed above that are
installed on your device. 
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You can enter information in Pocket Word in one of four modes (typing,
writing, drawing, and recording), which are displayed on the View menu.
Each mode has its own toolbar, which you can show and hide by tapping
the Show/Hide Toolbar button on the command bar.

Note: You can change the zoom magnification by tapping View then Zoom.
Then select the percentage you want. Select a higher percentage to enter
text and a lower one to see more of your document.
If you’re opening a Word document created on a computer, select Wrap to
Window on the View menu so that you can see the entire document.

Typing Mode

Enter text using the input panel (See “Entering Text Using the Input Panel”
on page 33 for more information). To format or edit text, highlight it by
dragging the stylus over the text you wish to select. Use the Edit menu or
toolbars for formatting changes. 

To search for text within a document, tap Edit then Find/Replace.

� Tap to change the formatting options.
� Tap to show or hide the toolbar.

Writing Mode

In writing mode, use your stylus to write directly on the screen. Ruled 
lines are displayed as a guide, and the zoom magnification is greater than
in typing mode to allow you to write more easily. For more information on
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Companion programs include Microsoft® Pocket Word, Microsoft® Pocket
Excel, Windows MediaTM Player for Pocket PC, and Microsoft® Reader.

To switch to a companion program, tap , then Programs, then the
program name.

Pocket Word
Pocket Word works with Microsoft® Word on your computer, providing
easy access to copies of documents. You can also create new documents on
your device or copy documents from your computer.

To create a new file, tap , Programs, Pocket Word, then New. Or,
from the Today screen, tap New, then Word Document. Only one
document can be opened at a time; when you open a second you will have
to save the first. Documents can be saved in a variety of formats including
Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text
(.txt).

Pocket Word contains a list of stored files. Tap a file to open it, and tap and
hold to delete, make copies of, or send it from the pop-up menu.

� Tap Name to change the sort order of the list.
� Tap All Folders to select the type of folder you want displayed in the

list.
� Tap New to create a new document.
� Tap on a document name to open the document.
� Tap and hold an item to see a pop-up menu of actions.
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� Tap to select formatting options, such as line weight, fill color,
and line color.

� Tap on the drawing to resize an object within the drawing. Drag the
selection handles until it is the size you want.

� From the pop-up menu, select Shape to convert an object to the
proper shape.

Recording Mode

In recording mode, you can embed a recording into your document.
Recordings are saved as .wav files. For more information on recording, see
“Entering Text Using the Input Panel” on page  33.

For more information on using Pocket Word, tap then Help.
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writing and selecting writing, see “Entering Text Using the Input Panel”
on page 33.

Note: If you cross three ruled lines in a single stylus stroke, the writing
becomes a drawing, and can be edited and manipulated as described in
the following section. 

Note: Written words are converted to graphics (metafiles) when a Pocket
Word document is converted to a Word document on your computer.

� Tap to select the Pen tool.
� Tap to select the Space tool. With Space tool selected, drag to

insert a space. An arrow appears showing the space direction and size.
� Tap to change the formatting options, such as pen weight and line

color.

Drawing Mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear as a
guide. When you lift your stylus off the screen after the first stroke, you’ll see a
drawing box indicating the boundaries of the drawing. Every subsequent
stroke within or touching the drawing box becomes part of the drawing. For
more information on drawing and selecting drawings, see “Entering Text
Using the Input Panel” on page 33.
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Tips for Working in Pocket Excel
� To view in full screen mode, tap View then Full Screen. Tap

Restore to exit mode.
� Tap View to select items you want to show or hide.
� To freeze panes, select the cell(s) you want to freeze, tap View then

Freeze Panes. Freeze the top and leftmost panes in a spreadsheet to
keep row and column labels visible as you scroll through a sheet.

� To split panes to view different areas of a spreadsheet, tap View then
Split. Drag the split bar to the desired location. To remove, tap View
then Remove Split.

� To hide a row or column, select it then tap Format, then Row or
Column, then Hide. To show a hidden row or column tap Tools,
then Go To, then type a reference that is in the hidden row or
column. Then tap Format, then Row or Column, then Unhide. 

For more information on using Pocket Excel, tap then Help.

MSN® Messenger
MSN® Messenger on your mobile device is an instant messaging program
that lets you:
� View a list of instant messaging contacts who are online.
� Send and receive instant messages.
� Have instant message conversations with groups of contacts.

To use MSN® Messenger, you must have a Microsoft PassportTM account or
a Microsoft® Exchange email account. If you have a Hotmail® or MSN®

account, you already have a Passport. Once you have obtained either a
Microsoft PassportTM or a Microsoft® Exchange account, you are ready to
set up your account.

Note: Sign up for a Microsoft PassportTM account at
http://www.passport.com. Get a free Microsoft® Hotmail® email address
at http://www.hotmail.com.

To switch to MSN® Messenger, tap , Programs, then tap MSN
Messenger. 
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Pocket Excel
Pocket Excel works with Microsoft® Excel on your computer, providing
easy access to copies of spreadsheets. You can also create new spreadsheets
on your device or copy spreadsheets from your computer.

To create a new file, tap , Programs, Pocket Excel, then New. Or,
from the Today screen, tap New, then Excel Workbook. Only one
spreadsheet can be opened at a time; when you open a second you will
have to save the first. Spreadsheets can be saved in a variety of formats
including Excel (.xls) and Pocket Excel (.pls). 

Pocket Excel contains a list of stored files. Tap a file to open it, and tap and
hold to delete, make copies of, or send it from the pop-up menu. 

Pocket Excel provides fundamental spreadsheet tools such as formulas,
functions, sorting and filtering. To display toolbar, tap View then Toolbar.

Note: If your spreadsheet contains sensitive information, you can
protect it with a password. To do so, open the file, tap Edit, then
Password. Every time you open that file, you will need to enter the
password.
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Note: If you block a contact, you will appear offline but will remain on
the blocked contact’s list. To unblock a contact, tap and hold the contact,
then tap Unblock on the pop-up menu.

Chatting With Contacts

Tap a contact name to open a chat window. Enter your message in the text
entry area, or tap My Text to enter a preset message, and tap Send. To
invite another contact to a multi-user chat, in the Tools menu, tap Invite
and tap the contact you wish to invite.

Note: To switch back to the main window without closing a chat, tap the
Contacts button. To revert back to your chat window, tap Chats and
select the person whom you were chatting with.

To see if the contact you are chatting with is responding, look for the
message under the text entry area.
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Setting Up

Before you can connect, you must enter Passport or Exchange account
information.

To set up an account and sign in:

1. In the Tools menu, tap Options.

2. On the Accounts tab, enter your Passport or Exchange account
information.

3. Tap OK.

4. Tap the sign-in screen and tap Sign in.

Note: If you use MSN® Messenger on your computer, your contacts will
automatically show up on your device.

Working With Contacts

The MSN® Messenger window displays all your message contacts divided
into Online and Not Online categories. While connected, tap and hold any
contact and a pop-up menu appears allowing you to chat, send email,
block the contact or delete the contact.

Note: To see others online without being seen, in the Tools menu, tap
My Status and select Appear Offline. 
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Windows MediaTM player can be used even if the screen is turned off.
Tap Tools, Settings then Buttons, and select Screen Toggle from the
pull-down list beside “Select Function”, then press the program
button you wish to allocate. By pressing the allocated button, you can
turn on and off the screen.

For more information about using Windows MediaTM Player for Pocket PC,
tap , then tap Help.

Microsoft® Reader
Microsoft® Reader enables you to read eBooks on your device. Using
ActiveSync®, book files can be copied from your computer to your device.

Each book consists of a cover page, an optional table of contents, and the
pages of the book. You can:
� Page through the book by using the cursor button on your device or

by tapping the page number on each page.
� Annotate the book with highlighting, bookmarks, notes, and

drawings.
� Search for text and look up definitions for words.

The Guidebook contains detailed information on using the software. To
open, tap Help on the Reader command bar. From a book page, tap and
hold the book title, then tap Help on the pop-up menu.

To open Microsoft® Reader, tap , Programs then Microsoft Reader.

Getting Books on Your Device

Download book files from the Web by visiting your favorite eBook retailer
and following the directions for downloading.

The Companion CD also includes sample books and a dictionary in the
MSReader folder of the APPS folder.

The Read Me file in the EBOOKS folder of the MSReader folder provides
directions for using ActiveSync® to download files from your computer.
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For more information on using MSN® Messenger, tap then Help.

Windows Media™ Player for Pocket PC
Use Microsoft® Windows MediaTM Player for Pocket PC to play digital audio
and video files that are stored on your device or on a network. To switch to
Windows MediaTM Player for Pocket PC, tap , then tap Windows
Media.

Use Microsoft® Windows MediaTM Player on your computer to copy digital
audio and video files to your device. You can play Windows MediaTM and
MP3 files on your device.
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� Tap on the title at the top of the page to select a navigation option.
� Tap on the arrows at the bottom of the page to turn the page. You

can also tap and hold the page number to bring up the page riffle.
� Drag cursor over text to select that text and reveal the pop-up menu.

Tap on the menu option for the action you want to perform.

You can also page through a book by using the cursor button on your
device.

Using Reader Features

Reading an eBook gives you several options not available with paper books.
Select text by dragging stylus across it and follow options outlined below:
� Search for Text: Find text by tapping Find on the pop-up menu.

Enter your search word and tap the desired Find option. Results are
highlighted on the page. Tap outside the box to close Find, and to
return to your original page, tap the title then Return on the pop-up
menu.

� Copy Text: You can copy text from books into any program that
accepts text. Select the text you want to copy, then tap Copy Text on
the pop-up menu. Paste it into the program of your choice.

� Bookmarks: When Add Bookmark is selected from the pop-up
menu, a color-coded bookmark appears in the right margin.
Multiple bookmarks can be added, and they can be accessed from
anywhere in the book by tapping the bookmark icon.
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Using the Library

The Library is your Reader home page; it displays a list of all books stored
on your device or storage card.

To open the Library:
� On the Reader command bar, tap Library. 
� On a book page, tap the book title, and then tap Library on the

pop-up menu.

To open a book, tap its title in the Library list.

� Tap Sort to select a sort order.
� Tap Show to specify the books you want to display in the list.

Reading a Book

Each book consists of a cover page, an optional table of contents, and the
pages of the book. Navigation options are listed in the bottom portion of
the cover page. 

The first time you open a book, you’ll probably want to go to the first page
or to the table of contents, if there is one. Subsequently, whenever you
open the book, you’ll be automatically taken to the last page read.

In addition to the text, each book page includes a page number and book
title.
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Favorite Links

During synchronization your computer’s Mobile Favorites folder is
synchronized with your device’s Pocket Internet Explorer. Both computers
are updated each time you synchronize. If the link is not marked as
mobile favorite, you will have to connect to PCS Connection to view page
content. For more information, see ActiveSync® Help on the computer.

Mobile Favorites 

If you are using Microsoft® Internet Explorer 5.0 or later on your
computer, you can download mobile favorites to your device. Synchronize
the web content of your mobile favorites downloads to your device so that
you can view pages while you are disconnected from PCS Connection and
computer.

Use the Internet Explorer plug-in installed with ActiveSync® to create
mobile favorites quickly.

To create a mobile favorite:

1. In Internet Explorer on your computer, click Tools then Create Mobile
Favorite.

2. To change the link name, enter a new name in the Name box. 

3. Optionally, in Update, select a desired update schedule.

4. Click OK. Internet Explorer downloads the latest version of the page to
your computer.

5. If you want to download the pages that are linked to the mobile
favorites you just created, right-click the mobile favorite then click
Properties. In the Download tab, specify the number of links deep you
want to download. To conserve device memory, go only one level deep.
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� Highlights: When text is highlighted, it appears with a colored
background.

� Notes: Enter text in the note that appears on top of the page. To show
or hide the note, tap the Note icon displayed in the left margin. 

� Drawing: When you add a drawing, a Drawing icon appears in the
top-right corner of the page along with tools on the bottom of the
page.

� Tap Go to then Annotations on the book’s cover page to see a list of
the book’s annotations including bookmarks, highlights, text notes
and drawings. Tapping an entry takes you to the annotated page.  

Removing a Book

When you finish reading a book, it can be deleted (to conserve space) by
tapping and holding the title in the Library list, and then Delete on the
pop-up menu.

Pocket Internet Explorer
Use Microsoft® Pocket Internet Explorer to view Web or WAP pages in
either of these ways:
� During synchronization with your computer, download your favorite

links and mobile favorites that are stored in the Mobile Favorites
subfolder in Internet Explorer on the computer.

� Connect to PCS Connection and browse the Web.

When connected to PCS Connection, you can also download files and
programs from the Internet.

To switch to Pocket Internet Explorer, tap then Internet Explorer.

The Mobile Favorites Folder 

Only items in your computer’s Mobile Favorites folder will be
synchronized with your device. This folder is automatically created when
ActiveSync® is installed.
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When synchronization is complete, tap the AvantGo Channels link in your
list of favorites to see a few of the most popular channels. To add or remove
channels, tap the Add or Remove link.

Using Pocket Internet Explorer

Pocket Internet Explorer can browse mobile favorites and channels that
have been downloaded to your device without connecting to the Internet.
Or, you can connect to the Internet through PCS Connection.

� Tap to refresh the page.
� Tap to go to the Home page.
� Tap to go to your favorites folder.
� Tap to hide pictures button.
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6. Synchronize your device and computer and the Mobile Favorites folder
will be downloaded to your device.

Note: If a scheduled update was not specified in step 3, content will
have to be manually downloaded to update both computers. To see the
last time content was downloaded to the computer, click Tools then
Synchronize from the Internet Explorer window. Manually download
content as needed.

Note: To add a button to your computer’s Internet Explorer toolbar for
creating mobile favorites, click View, Toolbars then Customize.

To minimize the amount of memory used by mobile favorites:

� In the Favorites settings, select ActiveSync® options and turn off
pictures and sounds, or stop select mobile favorites from being
downloaded. For more information see ActiveSync® Help.

� Limit the number of downloaded linked pages. On your computer’s
Internet Explorer, right click the mobile favorite you want changed
and then Properties. In the Download tab, specify 0 or 1 for the
number of linked pages you want to download.

Using AvantGo Channels

AvantGo, a free interactive service that provides access to personalized
content and popular websites, can be subscribed to directly from your
device. Content can be downloaded when you synchronize your device
and computer, or directly from the Internet. Visit the AvantGo website for
more information.

To sign up for AvantGo: 

1. In ActiveSync® options on the computer, turn on synchronization for
the AvantGo information type.

2. In Pocket Internet Explorer on your device, tap the Favorites button to
display your list of favorites.

3. Tap the AvantGo Channels link.

4. Follow the directions on the screen.
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Section 2J

Getting Connected

In This Section

� Transferring Items Using Infrared 

� Accessing the Internet Using Connection

� Ending a Connection

� Connecting Directly to an Email Server

� Get Help on Connecting

This section describes how to use infrared (IR) to exchange information
with other mobile devices and how to connect directly to the email server.
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Viewing mobile favorites:

1. Tap the Favorites button to display your list of favorites. 

� Tap Add/Delete to add or delete a folder or favorite link.

2. Tap the page you want to view. 

The version of the page that was downloaded the last time you
synchronized will be displayed. If the page is not on your device, the
favorite will be dimmed. Synchronize with your computer to download
the page to your device, or connect to the Internet to view the page.

Browsing the Internet:

1. Start the PCS Connection by turning on the Radio Standby Switch.

2. To connect and start browsing, do one of the following:
� Tap the Favorites button, and then tap the favorite you want to view.
� Tap View then Address Bar. Enter the destination web address and

tap . Tap the arrow to select from previously entered websites.

Note: To add a favorite link, tap and hold on the page and tap Add to
Favorites in the pop-up menu.
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Accessing the Internet Using PCS Connection
Access the Internet from the DATA tab of PCS Connection.

1. Open PCS Connection.

2. Tap DATA tab.

3. Tap the pull-down list and select the desired connection name.

4. Tap Connect to access the Internet.

Ending a Connection 
To disconnect, do one of the following:
� When connected via dial-up or VPN, tap the Connection icon, ,

on your navigation bar and tap End.
� When connected via cradle, detach your device from the cradle.
� When connected via Infrared, move the device away from the other

one.
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Your device can exchange information with other mobile devices as well
as your computer, a network, or the Internet. The connection options
include the following:
� The device’s infrared (IR) port can send and receive files from

another device. See “Transferring Items Using Infrared” below for
more information.

� When connected to the Internet via PCS Connection, you can send
and receive email by using Inbox and view web and WAP pages
using Pocket Internet Explorer. 

� Remotely connect to your computer to synchronize information
such as Pocket Outlook®. See ActiveSync® Help on your computer or
Connection Help on your device for more information.

Transferring Items Using Infrared
Using infrared (IR), you can send and receive information, such as
contacts and appointments, between two devices.

Sending Information:

1. Locate the item to send.

2. Align the IR ports so that they are unobstructed and within a close
range.

3. Tap and hold the item, and tap Beam Item on the pop-up menu.

Note: You can also send items, but not folders, from File Explorer. Tap
and hold the item you want to send, then tap Beam File on the pop-up
menu.

Receiving Information:

1. Align the IR ports so that they are unobstructed and within a close
range.

2. Have the owner of the other device send the information to you. Your
device will automatically receive it.
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Section 2K

Optional Functions

In This Section

� Home

� Backing Up

This section describes the Home program and Backup program, which can
be useful when using your device. 
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Connecting Directly to an Email Server
You can set up a connection to an email server so that you can send and
receive email messages by using a modem or network connection and
Inbox on your device.

Note: The ISP or network must use a POP3 or IMAP4 email server and
an SMTP gateway.

You can use multiple email services to receive messages. For each email
address you intend to use, set up and name the email service following the
directions below.

To set up an email service:

� In Inbox on your device, tap Services, then New Service. Follow
the directions in the New Service wizard.

For an explanation of a screen, tap then Help. When finished, to
connect to your email server, tap Services then Connect. For more
information on using the Inbox program, see “Inbox: Sending and
Receiving Email Messages” on page 104.

Get Help on Connecting
Additional help and information can be found in the following locations:
� “Inbox: Sending and Receiving Email Messages” on page 104.
� Online Help on the device. Tap then Help. Tap View, All

Installed Help, then Inbox or Connections.
� ActiveSync® Help on the computer. In ActiveSync®, click Microsoft

ActiveSync Help on the Help menu.
� For troubleshooting information, see the Pocket PC Web site at:

http://www.microsoft.com/mobile/pocketpc.
You can add up to 10 tabs, with up to 18 icons in each.
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About Running

The Running tab displays active applications. Icons do not appear.

To activate/stop the application:

� To activate an application, tap its name, or tap Activate in the pop-
up menu.

� To stop an application, tap its name then tap Stop in the pop-up
menu.

� To stop all applications, tap and hold anywhere on the Running tab
screen, then tap Stop All in the pop-up menu.

� Tap View to select Text Color.
� Tap Tools for Tab Settings or About.

Note: Tap and hold anywhere on the Running tab, except the application
names, and Stop All appears in the pop-up menu. 

Note: “Activate”, “Stop” and “Stop All” of the running application can
also be operated with Memory of System tab of Settings.
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Home
To easily launch the built-in or installed applications, tap the icon
displayed on the Home screen. 

Launching an Application From Home

1. Tap , Programs, then Home to display the Home screen.

You can also launch the Home by pressing the device Home Program
button.

For initial setting, the respective application icons are registered on three
tabs: Main, Programs and Games. In the Running tab, active
applications are displayed.

2. Tap the desired tab, then tap the application icon you want to launch.

Note: Press the Home Program button to switch tabs.
An application can also be launched by moving the cursor button to
select a program and pressing it to launch.

Note: You can add up to 10 tabs, with up to 18 icons in each.
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Note: If the icon is dragged and dropped in the same tab, it will return to
its original position on the tab screen.

Deleting an Icon

1. Tap and hold the icon to be deleted.

2. Tap Drop on the pop-up menu. 

Note: You cannot delete the PCS Connection icon.

Adding an Icon

Application and file icons can be added to the Home screen.

1. Tap Edit, then Add to display the Add Application screen.

You can also select Add from the pop-up menu displayed by tapping
and holding any portion other than the icon.

2. Tap of Application file box to show the file list. If there is no desired
file on the file list, you can find it by tapping Browse. To refer to all
folders and files, tap Browse to show the Browse Dialog screen. When
the file is selected, its name is displayed in the Application file box.

3. Enter an icon name (up to 32 characters) in the Application name box
that will display on the Home screen.

4. Tap OK when finished.

Display Icon List

The following list shows the tabs and icons for the initial setup.

Moving an Application Icon into Another Tab

A moved icon appears next to the last icon in its new location. It cannot be
moved to a tab that already contains 18 icons.

To move using pop-up menu:

1. Tap and hold the icon to be moved.

2. Tap Cut on the pop-up menu.

3. Tap the destination tab, then tap Paste on the Edit menu.

Note: You can also select Paste from the pop-up menu displayed by
tapping and holding any portion other than the icon.

To move using drag and drop:

Tap the icon you want to move and drag it to the destination tab, after the
tab name is highlighted, drop it.

The icon is transferred and deleted from its original location.

Pocket Internet 
Explorer

File Explorer

Backup

Infrared Receive

Solitaire

Windows Media™ 
Player

Notes

Tasks

Inbox

Calendar

Contacts

Pocket Word

Pocket Excel

Calculator

Running

Main

Programs

Games

Tabs Icons Applications Tabs Icons Applications

PCS Connection

Front Light

Power

Microsoft® Reader

MSN® Messenger
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Note: A new icon cannot be added if the Application file is not
designated or if the Application name is not entered. 

Note: An icon added from a storage card cannot be launched unless the
same card is inserted in the device.

Tab Setting

A tab can be added, deleted, or removed from the Tab Settings screen.

Adding a tab:

1. Tap Tools, then Tab Settings.

2. Tap New to display a text box.

3. Enter the new tab name (up to 10 characters) and tap OK when
finished.

4. Tap OK on the Tab Settings screen to return to the Home screen.

Deleting a tab:

1. Tap Tools, then Tab Settings.

2. Select the tab to delete, then tap Delete. Tap Yes or No in the
confirmation box. All icons contained in the tab will also be deleted.

3. Tap OK on the Tab Settings screen to return to the Home screen.

Note: You cannot delete the Running tab or the tab containing the PCS
Connection icon.

Changing the name of a tab:

1. Tap Tools, then Tab Settings.

2. Select the tab to be renamed and tap Rename.

3. Enter a new name (up to 10 characters), and tap OK when finished.

4. Tap OK on the Tab Settings screen to return to the Home screen.

Note: You cannot rename the Running tab.

Changing a background:

1. Select the background setup tab on the Tab Settings screen, then tap
Browse to display the Browse Dialog screen.

Even if a storage card is inserted, the files in the storage card will not be
displayed.

2. Tap the desired bitmap file from the list to return to the Tab Settings
screen.

3. Tap OK on the Tab Settings screen to return to the Home screen.

Note: Only bitmap files can be set on the screen background. The
displayable range of the bitmap image on the Home screen is 240 (W) x
246 (H) pixels.

Text Color Setting

To set the Text Color:

1. Tap the tab whose color you want to set to display the selected tab
screen.

2. Tap View, then Text Color to display the color list.

You can set the color of the application name as desired.

3. Tap the color you want to set, and the color of the application name
changes.

Backing Up
Device data can be backed up on a storage card, which can be later
restored to your device. Periodical data backup is strongly recommended.

The following types of data can be backed up:
� File: Files created by Pocket Word, Pocket Excel, Notes or

other installed programs. Other files stored in the
memory.

� Registry: Setting information on Windows® CE or Built-in
Program.

� Database: Microsoft® Pocket Outlook® database information.
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Note: Stored data, such as the password in Settings, is not restored.

Note: Before backing up, restoring, or deleting a backup file, connect an
AC Adapter to your device, set the Radio Standby Switch to OFF and
close all applications. Do not press any button or slide the switch while
the backup or restore is in progress. Otherwise, the operation of this
device is not guaranteed.

Note: If you update ROM programs using special installation programs
with a *.xip extension, do not use the backup data made before updating
the ROM programs.

Note: When the system was changed, data that was backed up before
the change cannot be restored.

Making a Backup

1. Insert a storage card.

2. Tap , Programs, then Backup to display the Backup screen.

3. Select Backup from Functionality. 

4. Tap OK to display the screen confirming all the applications are closed.

5. Tap OK to display the Backup password input screen.

6. Enter a password.

Note: If you choose a password, do not forget it. Backup data cannot be
restored without entering it.

7. Tap OK. The progress bar is displayed during the backup process.

When the backup is completed, the backup finish message appears.

8. Tap OK to return to the previous screen.

9. Tap Cancel to close the Backup screen.

Note: The backup process stops if the remaining storage card capacity
runs low. Check the storage capacity before starting to back up.

Note: If the storage card is write protected, it cannot save backup data.
Cancel the write protection before backing up.

Carrying Out Restore Operation 

To restore is to overwrite the backed up data from the storage card onto the
main memory of your device.
� If the same file name exists in the main memory of your device, this

file data is replaced with the backup data from the storage card.
� If files exist in the main memory but not in the backup file, they will

not be overwritten. 

1. Insert the storage card, which contains backup data into your device.
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3. Select Delete Backup File from Functionality.

4. Tap OK to display the Delete Backup File confirmation screen.

5. Tap OK to delete the backup file.
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2. Tap , Programs, then Backup to display the Backup screen.

3. Select Restore from Functionality.

4. Tap OK to display the screen confirming all the applications are closed.

5. Tap OK to display the Restore password input screen.

6. Enter the password that was established for the backed up data. If you
backed up without a password, you do not need to enter one.

7. Tap OK. The progress bar is displayed during the restore process.

When the restore is completed, the restore finish message appears.

8. Tap OK. Your device is reset and restarts automatically.

Note: If your device memory becomes short of its capacity during
restore, the restore process stops. Increase the memory allocation of the
main memory of your device (see “Setting Memory” in “Customizing Your
Device” on page 50), then restart the restore procedure.

Deleting a Backup File

1. Insert the storage card, which contains backup data to be deleted.

2. Tap , Programs, then Backup to display the Backup screen.
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Section 2L

Additional Information

In This Section

� Resetting

� Clearing Memory (Initialization)

� Specifications

This section describes how to reset and initialize your device.
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Specifications
External
dimensions
Operating
conditions

Built-in battery
Battery Life

Processor
Memory
Display
Interface

SD card slot

Infrared port

Stereo headset
jack
Cradle connection
port
AC Adapter jack

3 in. x 5 in. x 3/4 in. (excluding protrusion part)
(77.5(W) x 127.5(H) x 19.5(D) mm)
Temperature: 32°F to 104°F (0°C to 40°C),
Humidity: 30 to 80% RH
• Temperature capable of charging: 41°F to 95°F
(5°C to 35°C) (According to the operating status,
the charging may pause even when the ambient
temperature is below 95°F (35°C).)
Advanced Lithium Ion battery
Internal Lithium Ion Battery provides up to 1.5
hours of continuous talk time or up to 100 hours
of continuous standby time in digital mode.*
* These times are approximate, and depend on

network configuration, signal strength,
operating temperature, features selected, and
voice data and other application usage patterns.

Intel® StrongARM SA-1110 206MHz
32MB SDRAM
Reflective color TFT, 240x320 pixels, 65,536 colors

Possible to insert SD memory card or SDI/O card
Note: The security function of the SD memory

card is not usable. Data encrypted by 
the SD memory card security function-
compatible equipment is not usable.

Based on IrDA Ver.1.2, 
Maximum data transmission speed: 115 kbps
ø2.5mm, five poles stereo mini plug

Resetting
Reset is equal to “Restart” on a computer. Reset only in unusual
circumstances such as when the screen freezes and doesn’t respond to
tapping. Information not saved prior to resetting will be deleted.

When your device is reset, phone functions are ended. 

To reset, press and release the Reset Switch while the power is on. Once
reset, the Today screen appears. 

Note: If the function cannot be restored even after resetting, initialize
your device (see “Clearing Memory” on page 144).

� When the power is on, press the Reset Switch with the stylus, then
release. By doing so, reset is made and the Today screen appears.

Clearing Memory (Initialization)
Initializing the device returns it to the status when it was originally purchased.

Note: Initializing the device deletes all stored data, except built-in
programs. 
Before initialization, we recommend storing the memory data of the
device into your computer or a storage card. 

Note: Before initialization, remove a storage card.

To initialize:

1. Turn off the power.

2. Press the Power button while pressing and holding the Reset Switch
with the stylus, then release the Power button.

3. Release the Reset Switch.

When initialization is complete, the welcome screen appears. Proceed
with setup.
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Although the display is manufactured using an extremely high order of
technology, there may be a case that some dots do not light or always light.
It is not a malfunction.
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Using PCS 
Service Features

Section 3

Section 3
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Section 3A

PCS Service Features: 
The Basics

In This Section

� Using Voicemail

� Using Caller ID

� Responding to Call Waiting

� Making a Three-Way Call

� Using Call Forwarding

� Messaging

Now that you’ve mastered the phone function’s fundamentals, it’s time to
explore the calling features that enhance your PCS Service.
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New Voicemail Message Alerts

When you receive a new voicemail message, your device alerts you and
prompts you to call your voicemail. To call your voicemail, tap . To
display your Missed Log, tap .

Important: When you are roaming off the Sprint Nationwide PCS
Network, you may not receive notification of new voicemail messages. 
It is recommended that you periodically check your voicemail by dialing
1 + area code + your PCS Phone Number. When your voicemail answers,
tap and enter your pass code. You will be charged roaming rates
when accessing voicemail while roaming off the Sprint Nationwide 
PCS Network.

Note: Your device accepts messages even when it is turned off.
However, you are only notified of new messages when your phone
function is turned on and you are in a PCS Service Area.

Retrieving Your Voicemail Messages

You can review your messages directly from your PCS Device or from any
other touch-tone phone. To dial from your PCS Device, you can either
speed dial your voicemail. 

Using One-Touch Message Access:

� Tap and hold . Follow the system prompts.

Note: You are charged for airtime minutes when you are accessing your
voicemail from your PCS Device.

Using a Phone Other Than Your PCS Device to Access 
Your Messages:

1. Dial your PCS Phone Number.

2. When your voicemail answers, press .

3. Enter your pass code.

1
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Using Voicemail
Setting Up Your Voicemail

All unanswered calls to your PCS Device are automatically transferred to
voicemail, even if your device is in use or turned off. Therefore, you will
want to set up your PCS Voicemail and personal greeting as soon as your
PCS Device is activated.

To set up voicemail:

1. Tap and hold .

2. Follow the system prompts to create your pass code, record your
greeting, record your name announcement and choose whether to
activate One-Touch Message Access (a feature that lets you tap one key
to access messages and bypasses the need for you to enter your 
pass code).

Note: The voicemail setup process may vary in certain Affiliate areas.

Voicemail Notification
There are several ways your PCS Device alerts you:
� By displaying a message on the screen.
� By sounding the assigned ringer type.
� By displaying on the screen.

1
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Voicemail-to-Voicemail Message Forwarding

Forward a voice message, except those marked “Private,” to other 
PCS Voicemail customers.

1. After listening to a message, tap .

2. Follow the voice prompts to enter the phone number.

3. Follow the voice prompts to record your introduction and forward the
voice message.

Voicemail-to-Voicemail Receipt Request

Receive confirmation that your voice message has been listened to when
you send, forward or reply to a message to other PCS customers.

1. After you have recorded a message, tap to indicate you are
satisfied with the message you recorded.

2. Tap to mark receipt requested.

Continue Recording

� Before tapping to indicate you are satisfied with the message
you recorded, tap to continue recording.

Extended Absence Greeting

When your phone function is turned off or you are off the Sprint Nationwide
PCS Network for an extended period, this greeting can be played instead of
your normal personal greeting.

1. From the main voicemail menu, tap for Personal Options.

2. Tap for Greetings.

3. Tap to record an Extended Absence Greeting.3

3

3

4

1

4

1

6

Section 3: Using PCS Service Features
3A: The Basics 153

Voicemail Options

Your PCS Device offers several options for organizing and accessing 
your voicemail.

Setting Up Group Distribution Lists

Create up to 20 separate group lists, each with up to 20 customers.

1. Tap and hold to access your voicemail.

2. Following the system prompts, tap to change your 
Personal Options.

3. Tap for Administrative Options.

4. Tap for Group Distribution Lists.

5. Follow the voice prompts to create, edit, rename or delete group lists.

PCS Callback

Return a call after listening to a message without disconnecting 
from voicemail.

1. After listening to a message, tap .

2. Enter the phone number.

3. Once the call is complete, you’re returned to the voicemail main menu.

Voicemail-to-Voicemail Message

Record and send a voice message to other PCS Voicemail customers.

1. From the main voicemail menu, tap to send a message.

2. Follow the voice prompts to enter the phone number.

3. Follow the voice prompts to record and send your voice message.

Voicemail-to-Voicemail Message Reply

Reply to a voice message received from any other PCS Voicemail customer.

1. After listening to a voice message, tap .

2. Follow the voice prompts to record and send your reply.

88
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Responding to Call Waiting
When you’re on the phone and another call is received, you hear a call
waiting tone and “Call Alert From” appears on the display.

1. Tap to put the original party on hold and switch to the new caller.
When speaking to the new caller, the information for the first caller will
not be displayed.

2. Tap to switch to the original caller.

Tip: For those calls where you don’t want to be interrupted, you can
temporarily disable Call Waiting by tapping before
placing your call. Call Waiting is automatically reactivated once you end
the call.

Making a Three-Way Call
With Three-Way Calling, you can talk to two people at the same time.
When using this feature, the normal airtime rates will be charged for each
of the two calls.

1. When connected to one party, tap and enter the second party’s
number, then tap again.

2. When the second call is connected, tap to talk to both callers.

3. Tap to disconnect both parties.

If one of the people you called hangs up during your call, you and the
remaining caller stay connected. If you initiated the call and are the first
to hang up, all three callers are disconnected.

Tip: You can also begin a Three-Way Call by displaying a phone number
stored in your Contacts, Call History or Messaging.

Note: Call Waiting and Three-Way Calling are not available while
roaming off the Sprint Nationwide PCS Network.

07
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Using Caller ID
Caller ID lets you know who’s calling by displaying the number of the
person calling when your device rings. Similarly, if you call someone who
has this feature, your phone number displays on their phone. If the
caller’s name and number are already stored in your Contacts, the
corresponding name appears with the number. 

To block your phone number from being displayed for a specific 
outgoing call:

1. Tap .

2. Enter the number you want to call.

3. Tap .

To permanently block your number, call PCS Customer Solutions.

76
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Using Call Forwarding
Call Forwarding lets you forward all your incoming calls to another
phone number – even when your phone function is turned off. You can
continue to make calls from your device with Call Forwarding activated.

To Activate Call Forwarding

1. Tap , followed by the area code and phone number to
which your calls should be forwarded.

2. Tap . You will hear a tone confirming the activation of Call
Forwarding.

To Deactivate Call Forwarding

1. Tap .

2. Tap . You will see a message and hear a tone to confirm 
the deactivation.

Note: You are charged a higher rate for calls you have forwarded.

Messaging
Contact your service provider before using this function.

Tap Messaging on the Tools menu to display the message screen.

appears on the display when you receive a message.

Tap this indicator to open the message screen.

The following is a list of the icons displayed with the Message function.

Icon Meaning

Messages marked with this check will be deleted when
Delete is selected from the Edit menu.

027
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Message Screen

� The message that was received is displayed.
� Unread messages displayed in bold.

The following options can be selected through the File menu:

Call back Sender: Calls the sender back.

The following options can be selected through the Edit menu:

Delete: Deletes checked messages.

Delete All: Deletes all messages in box, regardless of whether or not they
are checked.

Add to New Contact: You can do a first time registration of selected
telephone numbers or email addresses. 

Add to Existing Contact: You can add selected telephone numbers or
email addresses to contacts that have already been registered in
Contacts.
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Section 3B

PCS VisionSM

In This Section

� PCS Business ConnectionSM

� Messaging

� Voice

� Web

With PCS Vision services, you will have access to additional features,
better performance, faster Internet connections and a wider variety of

online services.
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Voice

As always, make crystal-clear calls to anywhere from anywhere on our
nationwide PCS network.

Web
Experience full color graphic versions of your favorite Internet sites.

PCS Vision FAQs
How will I know when my device is ready for PCS Vision Service?

Your user name (for example, bsmith001@sprintpcs.com) will display
on your device's display screen.

How do I know when my device is connected to PCS Vision Services?

Your device automatically connects when PCS Vision Service is used or an
incoming message arrives.  (Connecting takes about 10-12 seconds.)

Can I make calls and use PCS Vision Services at the same time?

You cannot use voice and data services simultaneously. If you receive a
call while the data service is active, the call will be forwarded into
voicemail. You can place an outgoing call at any time, but it will interrupt
any in-progress data session.

When is my data connection active?

Your connection is active when data is being transferred. Outgoing calls
are allowed, but incoming calls go directly to voicemail.

When is my data connection dormant?

If no data is received for 10 seconds, the connection goes dormant. When
the connection is dormant, voice calls are allowed. (The connection can
go active again quickly.) If no data is received for a long time, the
connection will terminate.
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PCS Business ConnectionSM

Personal Edition
PCS Business ConnectionSM Personal Edition is designed to offer secure
wireless access to both Microsoft Outlook and Lotus Notes.

PCS Business Connection Personal Edition delivers the 
following features:
� Business email access: Read, reply to, forward, delete and compose

your company email.
� Company directory and contacts: Search, view, call, and email

contacts from your company's directory. Do all this and add/edit 
your personal contacts.

� Work calendar: Accept and reject meetings, view daily summaries 
and details, navigate to various dates.

� Files/information on your PC: Browse folders, download and 
view documents from any device using a PC browser or Pocket 
Internet Explorer.

To use PCS Business Connection Personal Edition, install Business
Connection Personal Edition software on your work PC. This allows data
to be securely retrieved in real-time by your wireless device when
connected to the Sprint Nationwide PCS Network. There is a monthly
charge for PCS Business Connection, and usage charges will also apply.

When your work PC isn't on, you can share connections with your 
co-workers so that you always have access to your email, calendar and
contacts. Your data remains secure behind the corporate firewall and any
changes you make on your wireless device are instantly updated on your
corporate server without the need to synchronize.

Additional Business Connection solutions are available to your company.
For more details, visit businessconnection.sprintpcs.com.

Messaging
Send and receive email and instant messages or chat with friends.
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Section 3C

PCS Voice CommandSM

In This Section

� PCS Voice CommandSM

With Sprint, the first wireless provider to offer innovative PCS Voice
Command technology, reaching your friends, family, co-workers and

teammates has never been easier – especially when you’re on the go. You can
even listen to Web-based information such as news, stock quotes, weather,
sports and much more. Your voice does it all with PCS Voice Command.
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� Call Directory Assistance: If you don’t have a computer or Internet
access handy, you can have PCS Directory Assistance look up phone
numbers for you and automatically add them to your address book.
Just say, “Call operator,” and we’ll add two names and numbers to your
address book for our standard directory assistance charge.

Making a Call With PCS Voice Command
1. Once you’ve signed up for PCS Voice Command and created your

address book, all you do is tap . You’ll hear a tone followed
by the prompt “Ready.”

2. After the “Ready” prompt, simply say, in a natural voice, “Call” and 
the name of the person or the number you’d like to call. For example,
you can say, “Call Jane Smith at work,” “Call John Baker on the mobile
phone,” “Call 555-1234” or “Call Bob Miller.”

3. Your request will be repeated and you will be asked to verify. Say “Yes” to
call the number or person. Say “No” if you wish to cancel.

4. The number will automatically be dialed. Keep in mind that PCS Voice
Command recognizes not only your voice, but any voice, so that others
can experience the same convenience if they use your device.

For more helpful hints on PCS Voice Command, including a list of recognized
commands and an interactive tutorial, visit www.talk.sprintpcs.com.

Accessing Information Using 
PCS Voice Command

1. Tap .

2. Say “Call the Web.” (To access, listen to and respond to email, once 
email has been set up, say “Call My Email.”)

3. Choose from a listing of information categories like news, weather,
sports and more.

Note: PCS Voice Command is not available while roaming off the
enhanced Sprint Nationwide PCS Network.
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Getting Started With PCS Voice Command
With PCS Voice Command:
� You can store all your contact’s phone numbers, so you can simply say

the name of the person you want to call.
� There’s no need to punch in a lot of numbers, memorize voicemail

passwords or try to dial while you’re driving.
� You can call anyone in your address book – even if you don’t remember

their phone number.

It’s Easy to Get Started

Just dial from your PCS Deviceto activate the service and
listen to brief instructions directly from your device. There is a monthly
charge for PCS Voice Command.

Creating Your Own Address Book
You can program up to 500 names into your personal address book, with
each name having up to five phone numbers. That’s 2,500 phone
numbers – and with the advanced technology of PCS Voice Command –
you can have instant access to all of them. 

There are four ways to update your address book:

� Use Voice Recordings: Simply dial and say, “Add name.”
You will then be asked to say the name and number you want to add to
your personal address book. Your address book can store up to 20 voice
recorded names at once.

� On the Web: Go to www.talk.sprintpcs.com and receive a fully
functional Web-based address book to create and update your contacts.

� Use an Existing Address Book: Automatically merge address books
from desktop software applications with Sprint SyncSM Services for no
additional charge. Simply click on the “Click to synchronize” button
within your PCS Voice Command personal address book at
www.talk.sprintpcs.com.
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Section 4A

Safety

In This Section

� Getting the Most Out of Your Reception

� Maintaining Safe Use of and Access to Your Device

� Safety Instructions

� Acknowledging Special Precautions and the FCC Notice

� SAR Information

� Consumer Update on Wireless Phones

� Owner’s Record

� User Guide Proprietary Notice

Part of getting the most out of your device is knowing where and 
how it works at optimum efficiency. This section outlines performance

and safety guidelines that ensure you experience the full quality that your
device was designed to give you.
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Maintaining Your Device Peak Performance

There are several simple guidelines to operating your device properly and
maintaining safe, satisfactory service. 
� Don’t use the device if the antenna is damaged.
� Speak directly into the mouthpiece. 
� Avoid exposing your device and accessories to rain or liquid spills. 

If your device does get wet, immediately turn the power off and
remove the battery. If it’s inoperable, return it to a Sprint Store or 
call PCS Customer Solutions for service.

Note: For the best care of your device, only Sprint authorized personnel
should service your device and accessories. Faulty service may void 
the warranty.

Maintaining Safe Use of and Access to 
Your Device

FAILURE TO FOLLOW THE INSTRUCTIONS OUTLINED MAY LEAD TO
SERIOUS PERSONAL INJURY AND POSSIBLE PROPERTY DAMAGE

Using Your Device While Driving

Talking on your device while driving (or operating the device without a
hands-free device) is prohibited in some jurisdictions. Laws vary as to
specific restrictions. Remember that safety always comes first.

When using your device in the car:
� Get to know your device and its features, such as speed dial 

and redial.
� When available, use a hands-free device.
� Position your device within easy reach.
� Let the person you are speaking to know you are driving; if

necessary, suspend the call in heavy traffic or hazardous 
weather conditions.

� Do not take notes or look up phone numbers while driving.
� Dial sensibly and assess the traffic; if possible, place calls when

stationary or before pulling into traffic.
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Getting the Most Out of Your Reception
Keeping Tabs on Signal Strength

The quality of each call you make or receive depends on the signal
strength in your area. Your device informs you of the current signal
strength by displaying a number of bars next to the signal strength icon.
The more bars displayed, the stronger the signal. If you’re inside a
building, being near a window may give you better reception.

Understanding the Power Save Feature

If your device is unable to find a signal after 15 minutes of searching, a
Power Save feature is automatically activated. If your device is active, it
periodically rechecks service availability or you can check it yourself by
pressing any key. When a signal is found, your device returns to Standby
mode. 

Understanding How Your Device Operates

Your device is basically a radio transmitter and receiver. When it’s turned
on, it receives and transmits radiofrequency (RF) signals. When you use
your device, the system handling your call controls the power level. This
power can range from 0.006 watts to 0.2 watts in digital mode.

Knowing Radiofrequency Safety

The design of your device complies with updated NCRP standards
described below.

In 1991-92, the Institute of Electrical and Electronics Engineers (IEEE)
and the American National Standards Institute (ANSI) joined in updating
ANSI’s 1982 standard for safety levels with respect to human exposure to
RF signals. More than 120 scientists, engineers and physicians from
universities, government health agencies and industries developed this
updated standard after reviewing the available body of research. In 1993,
the Federal Communications Commission (FCC) adopted this updated
standard in a regulation. In August 1996, the FCC adopted hybrid
standard consisting of the existing ANSI/IEEE standard and the
guidelines published by the National Council of Radiation Protection and
Measurements (NCRP).
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NOTE: Designates important information that relates to activities and/or
conditions that might result in loss of data and/or damage to your device.

Safe Use And Operation of Your Device
All portable computers produce low levels of RF energy due to the
generation of digital timing pulses by its clock oscillator circuits. Your
device has been equipped with internal shielding to minimize stray
emissions of RF energy. Airlines may nevertheless prohibit the on-board
use of portable PCs (and all other portable electronic devices that could
potentially emit stray RF energy), particularly during take-offs and
landings, to prevent any possible interference with the reception of
signals by airborne electronic navigational devices. Other locations,
such as hospitals, may also restrict the use of Pocket PC’s and other
devices that emit low-level RF energy.

WARNING
� Always request and obtain prior consent and approval of an

authorized airline representative before using your device aboard an
aircraft.

� Always follow the instructions of the airline representative whenever
using your device aboard an aircraft, to prevent any possible
interference with airborne electronic equipment.

WARNING
� Always comply with posted prohibitions of the use of RF-emitting

devices, such as in hospitals. Failure to follow such directives could
result in the interference with medical equipment and/or devices.

� Never come closer than 6 inches to a person with a heart pacemaker
implant when using this device. Failure to do so could result in
interference with the function of the pacemaker.

WARNING
� Never use your device while driving an automobile or any other

moving vehicle. Always pull out of traffic and come to a stop in a
legally permissible and safe location before using your device. Failure
to do so could result in serious bodily injury in a traffic accident.
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� Do not engage in stressful or emotional conversations that may
divert your attention from the road.

� Dial to report serious emergencies. It’s free from
your device.

� Use your device to help others in emergencies. 
� Call roadside assistance or a special non-emergency wireless number

when necessary.

Safety Instructions
• It is recommended that important data stored in your device should be

saved to a memory card (sold separately) or your personal computer
(data transfer with ActiveSync®) on a regular basis. Before returning
your unit for service, be sure to back up your data and remove any
confidential, proprietary or personal information. Sprint is not
responsible for damage to or loss of any programs, data or removable
storage media.

• There are two categories of Safety Instructions included in this guide:

-Product Warnings, (i.e., what must never be done to assure avoiding
those hazards that could cause bodily injury or property damage);
and

-User Directions (i.e., what must always be done to assure the safe use
of your device).

• The Safety Instructions contained in this guide have been
categorized in accordance with the seriousness of the potential
hazards through the use of Signal Words.
Those Signal Words, and their intended meanings, are as follows:

DANGER: Indicates that a failure to observe the Safety Instructions
could result in death or catastrophic bodily injury.

WARNING: Indicates that a failure to observe the Safety Instructions
could result in serious bodily injury.

CAUTION: Indicates that a failure to observe the Safety Instructions
could result in minor bodily injury or property damage.

119
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� Always immediately remove your device and its battery from the
vicinity of any source of heat, such as an open flame, in the event
the built-in battery leaks liquid or emits an unusual odor. Continued
use of your device under either of these conditions could cause
ignition (i.e., fire) of the leaked battery liquid, or rupture.

� Never touch any fluid that might leak from the built-in battery. Such
liquid when in contact with the eyes or skin, could cause injury to
the skin or eyes. Should the liquid come into contact with the eyes,
irrigate the eyes thoroughly with clean water and immediately seek
medical attention. In the event the liquid comes into contact with
the skin or clothing, wash it away immediately with clean water.

Failure to follow the above directions concerning use and storage could
result in bodily injury and/or property damage due to battery liquid
leakage, fire or rupture. Failure to follow the above directions concerning
use and storage could also result in damage to your device.

WARNING
� Always use authorized Sprint accessories and optional devices when

operating this device, as the use of incompatible auxiliary
equipment could result in fire, electric shock or other bodily injury.
The use of unauthorized accessories will also void your Warranty.

WARNING
� Never attempt to disassemble, repair or make any modification to

your device. Disassembly, modification or any attempt at repair
could cause bodily injury or property damage, as well as damage to
the device itself.

WARNING
� Your device is not a toy. Never allow children to play with your

device. Misuse, rough or improper handling of your device by
children could result in serious bodily injury for any of the
enumerated safety warnings in this guide. In addition, always keep all
accessories and components out of the reach of small children as
small parts might present a choking hazard. Seek immediate
medical attention if choking occurs or if any small part has been
swallowed.
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� Never use your device while walking. Usage while walking could result
in bodily injury caused by inattention to automobile traffic or other
pedestrian hazards.

WARNING
� Never allow metallic objects, such as staples and paper clips, to enter

inside your device. Metallic objects, such as staples and paper clips, if
allowed to enter your device, could cause the generation of excess
heat or fire.

� Never connect terminals (metal parts) to metallic objects (such as
wires). Connecting terminals to metal objects could cause excessive
heat or fire.

� Always immediately disconnect the AC Adapter from the power outlet
and turn the battery switch to the “Stop” position in the event the
device emits an unusual odor or sound or generates smoke.

WARNING
� Never use or store your device in the following locations:

-Anywhere it may be exposed to water, such as a bathroom or sauna;

-In conditions of high humidity, such as in the rain or fog;

-Where your device will be exposed to high temperatures, such as near a
fire or equipment that emits high temperatures;

-In direct sunlight; or

-In a sealed automobile left in the sun and subject to high
temperatures.

-Never store or transport flammable liquids, gases or explosive
materials in the same compartment of your automobile as the device
or any of its accessories, as possible sparking in the PC could cause
ignition or explosion.

-When driving, always secure your device in its softcase, when it is not
in use. Never place your device on the passenger seat or any place else
in the car where it can become a projectile during a collision or stop.

� Never drop your device or subject it to severe shock. Dropping your
device or subjecting it to severe shock could cause the built-in
battery to leak, ignite and/or rupture.
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computer, you should touch a grounded object to discharge any static
electricity from your body.

� Do not subject your device to sudden and severe temperature
changes. This could result in moisture condensation in the device
that could cause damage to your device, computer function loss,
and/or the loss of data. In the event of moisture condensation, allow
your device to dry out completely.

� It is normal for the AC Adapter to become warm when charging.
� Disconnect the power plug from the outlet when not in use.
� Take care not to sit on device when it is located in the back pocket of

trousers, etc. This could cause damage to your device or malfunction
of the device functions.

� Do not place objects on top of your device or drop them on top of
your device. This could cause damage to your device and/or
malfunction.

� Never paint or apply any foreign substance to this device as this can
clog and damage moving parts.

� Clean terminals (metallic parts) on a regular basis with a dry cotton
swab. Dirty terminals could affect battery charging.

� Never use organic solvents such as benzene or paint thinner to clean
your device. Use of these solvents can cause deformation or
discoloration. Wipe dirty parts with a soft dry cloth.

� Do not wipe the display with a damp or wet cloth or touch the
display with damp or wet hands. Wiping or touching the display
under this condition can cause product failure or malfunction.
Always use a soft dry cloth to wipe the display.

� When using the optional “SD memory card”, be sure to read the
relevant instruction manual and ensure that you know the proper
procedures for their use and compatibility with your device.
-Never subject the card to any severe shock while connected to your
device. Such a shock can cause damage to the card and a 
malfunction.

-Do not carry your device with the card connected to it. 
This can result in the damage or loss of the card.
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CAUTION
� Never raise the sound volume level too high when using your device

with headset. An excessive sound volume level could cause damage
to your hearing.

� Never touch the liquid that might leak from a broken liquid crystal
display. Contact with this liquid could cause a skin rash. If the
crystal display liquid should come into contact with the skin or
clothing, wash it immediately with clean water.

NOTE
� Under certain conditions, data may be lost, including:

-Failure to follow all instructions for use and warnings in this guide.

-Misuse of your device;

-Subjecting the main unit of your device to static electricity and/or
noise;

-Total loss of electric charge in the built-in battery; and

-Servicing of your device.
� Use of your device in locations where the following ambient

environmental conditions are exceeded: 

-Under normal operational use ambient temperatures not less than
32°F and not in excess of 104°F (0°C and 40°C);

-With humidity of not less than 30% or in excess of 80%; and

-When charging the battery ambient temperatures not less than 41°F
and not to exceed 95°F (5°C and 35°C).

� Do not store or use your device in the following locations:

-Those subject to extremely high or low temperatures;

-Dusty locations; and

-Locations or sites subject to strong vibration.
Use or storage in these location, sites or areas can result in product
failure, malfunction or loss of data.

� Avoid connecting your device to an external device such as a
computer in an environment likely to be affected by static electricity.
For example, during low-humidity weather, shuffling your shoes
upon a rug can produce static electricity. Before you handle your
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in the risk of electric shock. Never attempt to modify or alter the AC
cord or plug of the AC Adapter.

WARNING
� Never allow the AC Adapter to come into contact with water or any

other liquid. Water or any other liquid in contact with the AC
Adapter can create a risk of fire or electric shock.

� Always use the authorized Sprint AC Adapter to avoid any risk of fire
or damage to your device or battery. Bodily injury or property
damage may occur as a result of the use of an unauthorized and
incompatible AC Adapter.

� Never use an AC Adapter if it has a damaged or worn power cord or
plug. The use of damaged or worn power cords or plugs could result
in electric shock, burns or fire. Contact an authorized Sprint service
center immediately to obtain a suitable replacement. 

� Never connect or disconnect the AC Adapter with wet hands.
Connecting or disconnecting the AC Adapter to a power source with
wet hands could cause electric shock.

� Never attempt to connect or disconnect the power plug with damp or
wet hands. Connecting or disconnecting the power plug with damp
or wet hands could result in an electric shock.

� Always unplug the AC Adapter from the power source before
attempting any cleaning in order to avoid the risk of electric shock.
Always use a soft dry cloth to clean the equipment, after it has been
unplugged.

� Never attempt to use an unauthorized AC Adapter with your device in
order to avoid any risk of bodily injury or property damage. Since
unauthorized accessories have different specifications, they may be
incompatible with your device.

CAUTION
� Never place an AC Adapter on a wooden surface (or any other

surface that could be marred by exposure to heat) while it is in use.
Since its surface temperature of the AC adapter increases during
normal use, always rest it on a suitable heat-insulating material.
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� When the device is operating, do not insert or remove the “SD
memory card” into or out of the SD card slot or connect or
disconnect the device from the cradle as this may cause loss of stored
data, or product failure/malfunction.

� Never connect cradle terminals with metallic objects, such as wires.
Connecting these terminals with metallic objects may cause the
production of excess heat, burns and damage to the charger and/or
your device.

� To avoid eye strain, take frequent visual breaks, focusing on objects
located at a distance greater than 15 feet.

CAUTION
� A lithium ion battery is used in this device. When a replacement is

needed, please request the dealer from whom your device was
purchased to assist you.

� Lithium ion batteries are recyclable. When you replace your built-in
battery, please request the repair center to recycle the battery in
accordance with RBRC standards. When disposing of the battery by
yourself, please call RBRC at (800) 822-8837 for tips on the proper
disposal of the lithium ion battery. Never dispose of the battery with
ordinary waste. 

Safe Use of AC Adapter
DANGER
� Never attempt to disassemble or repair an AC Adapter, and never alter

the power cords or plugs as exposure to electric shock hazards may
result. 
Always contact an authorized Sprint service center, if repair or
replacement is required.

� If the plug will not fit into the available outlet, have a proper outlet
installed by a qualified electrician. Improper connection can result
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other foreign material accumulation on the power plug pins could
cause fire.

� Be certain to insert the power plug deeply into a socket. Failure to do
so could cause a fire and an electric shock.

� Always disconnect the AC Adapter from the power source when it is
not in use.

Acknowledging Special Precautions and the 
FCC Notice

FCC Notice  "Declaration of Conformity Information" 
Product Name: 2032SP
Model Number(s): CET0200B (PDA2032SP)

This equipment has been tested and found to comply with the limits for
a Class B digital device, pursuant to part 15 of the FCC Rules. These
limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses
and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio
communications.
However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to
radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that

to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Warning: Only peripherals complying with the FCC class B limits
may be attached to this equipment.
Operation with non-compliant peripherals or peripherals
not recommended by us is likely to result in interference to
radio and TV reception. Shielded cables must be used
between the external devices and the cradle connecting
port.
Changes or modifications made to this equipment, not
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� Never cover the AC Adapter with any object while it is in use, and
never place it adjacent to a heat source. An excessive temperature
increase could detrimentally affect its performance.

� Never place a Power Supply Cable near a heat source, as damage to
the cord or to its insulation could result.

� Always use a surge protector when utilizing the AC Adapter during
an electrical storm. Otherwise, a power surge could result in the loss
of stored data.

� Always use a surge protector when utilizing the AC Adapter near an
electrical noise source such as high voltage line or power source.
Otherwise, a power surge could result in loss of stored data.

� In order to avoid any possibility of a fire, always insert the power
plug into household electric outlet supplying 120V AC.

� When traveling abroad, never plug the AC Adapter into a power
source that does not correspond to both the voltage and the
frequency specified on the rating plate of the AC Adapter, as
equipment damage and fire will result. When you connect to a
power supply of more than 125V AC, change the Power Supply Cable
with one that corresponds to the power supply specification. Failure
to do so could cause a fire.

CAUTION
� Never drop the AC adapter or subject it to severe shock. This may

cause ignition or electric shock, as well as damage to the adapter. 
� Always locate an accessory Power Supply Cable so that it will not be

stepped on, tripped over, or otherwise subjected to damage or stress.
� Never place heavy objects on a Power Supply Cable, as this could

result in damage to the cord.
� Never bend or twist a Power Supply Cable, and never pull on a Power

Supply Cable in an attempt to remove an AC Adapter or accessory
plug from a socket. Always grasp the AC Adapter or the accessory
plug directly when unplugging the Power Supply Cable in order to
avoid damaging the cable.

� Always ensure the power plug pins are clean and free of dust or other
foreign material by wiping the pins with a clean dry cloth. Dust or
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SAFE USE AND OPERATION OF DEVICE (WIRELESS
HANDHELD PHONE)

Read this information before using your device. 
Your device is a low power radio transmitter and receiver. When it is
ON, it receives and also sends out radiofrequency (RF) signals. 

FCC RF EXPOSURE INFORMATION
In August 1996, the Federal Communications Commission (FCC) of
the United States, with its action in Report and Order FCC 96-326,
adopted an updated safety standard for human exposure to
radiofrequency (RF) electromagnetic energy emitted by FCC regulated
transmitters. Those guidelines are consistent with the safety standard
previously set by both U.S. and international standards bodies. The
design of this device complies with the FCC guidelines and these
international standards.

Use only the supplied or an approved antenna. Unauthorized antennas,
damaged antennas, modifications, or attachments could impair call
quality, damage the phone, or result in violation of FCC regulations.
Please contact your local dealer for replacement antenna.

Body-worn Operation
This device was tested with the Softcase with Belt Clip offered by Sprint,
as an accessory to this device and was found to comply with the FCC
exposure requirements. Other third-party belt clip and softcase or
holsters have not been tested with this device and therefore their
compliance with the FCC RF exposure limits cannot be confirmed.
When operating this device, a minimum separation distance of 1 inch
(2.5 cm) must be maintained between the user’s body and the device,
including its antenna, to comply with the FCC exposure limits.
This particular device has not been designed for held-to-ear use and
should never be used against the ear. It is designed to be used in a belt
clip with a Phone Headset or as a speakerphone.

For more information about RF exposure, please visit the FCC website
at www.fcc.gov.
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expressly approved by us or parties authorized by us could
void the user’s authority to operate the equipment.

This device complies with part 15 of the FCC Rules. Operation is subject
to the following two conditions:
(1) This device may not cause harmful interference, and 
(2) this device must accept any interference received, including

interference that may cause undesired operation.

Product Name: USB Cradle
Model Number(s): CEX0208B (CRU2032B)

This equipment has been tested and found to comply with the limits for
a Class B digital device, pursuant to part 15 of the FCC Rules. These
limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses
and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to
radio communications.
However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference
to radio or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that

to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

This device complies with part 15 of the FCC Rules. Operation is subject
to the following two conditions:
(1) This device may not cause harmful interference, and 
(2) this device must accept any interference received, including

interference that may cause undesired operation.
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Persons with pacemakers:
• Should ALWAYS keep the device more than six (6”) inches from their

pacemaker when the device is turned ON.
• Should not carry the device in a breast pocket.
• If you have any reason to suspect that interference is taking place,

turn your device OFF immediately.

WARNING
Vehicles
RF signals may affect improperly installed or inadequately shielded
electronic systems in motor vehicles. Check with the manufacturer or its
representative regarding your vehicle. You should also consult the
manufacturer of any equipment that has been added to your vehicle.

Posted Facilities
Turn your device OFF in any facility where posted notices require so.

AIRCRAFT
FCC regulations prohibit using your device while in the air. Turn your
device OFF before boarding an aircraft.

BLASTING AREAS
To avoid interfering with blasting operations, turn your device OFF when
in a “Blasting area” or in areas posted “Turn off two-way radio”. Obey all
signs and instructions.

POTENTIALLY EXPLOSIVE ATMOSPHERES
Turn your device OFF when in any area with a potentially explosive
atmosphere and obey all signs and instructions. Sparks in such areas
could cause an explosion or fire resulting in bodily injury or even death.
Areas with a potentially explosive atmosphere are often, but not always
marked clearly. Potential areas may include: fueling areas (such as
gasoline stations); below deck on boats; fuel or chemical transfer or
storage facilities; vehicles using liquefied petroleum gas (such as propane
or butane); areas where the air contains chemicals or particles (such as
grain, dust, or metal powders); and any other area where you would
normally be advised to turn off your vehicle engine.

For Vehicles Equipped with an Air Bag
An air bag inflates with great force. DO NOT place objects, including either
installed or portable wireless equipment, in the area over the air bag or in
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PHONE OPERATION
When speaking into the Microphone or the Phone Headset, a minimum
separation distance of 1 inch (2.5 cm) must be maintained between the
user's face and the device, including its antenna, to comply with the FCC
exposure limits.

This particular device has not been designed for held-to-ear use and
should never be used against the ear.

In front of your face, hold the device keeping distance from your body. or,
In front of your face, hold the device wearing the earpiece keeping
distance from your body.

Tips on Efficient Operation:
For your phone to operate most efficiently:
• Do not touch the antenna unnecessarily and keep the antenna from

metal when the phone is in use. Contact with the antenna affects
call quality and may cause the phone to operate at a higher power
level than otherwise needed.

WARNING
DRIVING
Never use a device and/or cell phone while driving an automobile or any
other moving vehicle. Always pull out of traffic and come to a stop in a
legally permissible and safe location before using your device. Failure to
do so could result in serious bodily injury in a traffic accident.

WARNING
ELECTRONIC DEVICES
Most modern electronic equipment is shielded from RF signals. However,
certain electronic equipment may not be shielded against the RF signals
from your device.

Pacemakers
The Health Industry Manufacturers Association recommends that a
minimum separation of six (6") inches must be maintained between your
device and a pacemaker to avoid potential interference with the
pacemaker. These recommendations are consistent with the independent
research and recommendations of Wireless Technology Research.
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SAR Information
Specific Absorption Rate

THIS MODEL PHONE MEETS THE GOVERNMENT’S
REQUIREMENTS FOR EXPOSURE TO RADIO WAVES.
Your wireless phone is a radio transmitter and receiver. It is designed and
manufactured not to exceed the emission limits for exposure to
radiofrequency (RF) energy set by the Federal Communications
Commission of the U.S. Government. These limits are part of
comprehensive guidelines and establish permitted levels of RF energy for
the general population. The guidelines are based on standards that were
developed by independent scientific organizations through periodic and
thorough evaluation of scientific studies. The standards include a
substantial safety margin designed to assure the safety of all persons,
regardless of age and health.

The exposure standard for wireless mobile phones employs a unit of
measurement known as the Specific Absorption Rate, or SAR. The SAR
limit set by the FCC is 1.6 W/kg.* Tests for SAR are conducted with the
phone transmitting at its highest certified power level in all tested
frequency bands. Although the SAR is determined at the highest certified
power level, the actual SAR level of the phone while operating can be well
below the maximum value. This is because the phone is designed to
operate at multiple power levels so as to use only the power required to
reach the network. In general, the closer you are to a wireless base station
antenna, the lower the power output. 

Before a phone model is available for sale to the public, it must be tested
and certified to the FCC that it does not exceed the limit established by the
government-adopted requirement for safe exposure. The tests are
performed in positions and locations (e.g., worn on the body) as required
by the FCC for each model. The highest SAR value for this model phone
tested when being worn on the body, as described in this user guide, is
0.56W/kg. (Body-worn measurements differ among phone models,
depending upon available accessories and FCC requirements). While
there may be differences between the SAR levels of various phones and at
various positions, they all meet the government requirement for safe
exposure.
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the air bag deployment area. If in-vehicle wireless equipment is
improperly installed and the air bag inflates, serious injury could result.

CAUTION
Hearing Aids

Some digital wireless phones may interfere with some hearing aids. In the
event of such interference, you may want to consult your service provider
[or call the customer service line to discuss alternatives].

Other Medical Devices

If you use any other personal medical device, consult the manufacturer of
your device to determine if they are adequately shielded from external RF
energy. Your physician may be able to assist you in obtaining this
information.

Turn your device OFF in health care facilities when any regulations posted
in these areas instruct you to do so. Hospitals or health care facilities may
be using equipment that could be sensitive to external RF energy.

Note: “device OFF” means to turn the Radio Standby Switch “OFF”, then
turn the power off using the Power button.
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Consumer Update on Wireless Phones
U.S. Food and Drug Administration - Center for Devices and Radiological
Health 

1. Do wireless phones pose a health hazard? 

The available scientific evidence does not show that any health problems
are associated with using wireless phones. There is no proof, however, that
wireless phones are absolutely safe. Wireless phones emit low levels of
radiofrequency energy (RF) in the microwave range while being used.
They also emit very low levels of RF when in the stand-by mode. Whereas
high levels of RF can produce health effects (by heating tissue), exposure
to low level RF that does not produce heating effects causes no known
adverse health effects. Many studies of low level RF exposures have not
found any biological effects. Some studies have suggested that some
biological effects may occur, but such findings have not been confirmed
by additional research. In some cases, other researchers have had
difficulty in reproducing those studies, or in determining the reasons for
inconsistent results.

2. What is FDA’s role concerning the safety of wireless phones? 

Under the law, FDA does not review the safety of radiation-emitting
consumer products such as wireless phones before they can be sold, as it
does with new drugs or medical devices. However, the agency has authority
to take action if wireless phones are shown to emit radiofrequency energy
(RF) at a level that is hazardous to the user. In such a case, FDA could
require the manufacturers of wireless phones to notify users of the health
hazard and to repair, replace or recall the phones so that the hazard no
longer exists.

Although the existing scientific data do not justify FDA regulatory actions,
FDA has urged the wireless phone industry to take a number of steps,
including the following:
• Support needed research into possible biological effects of RF of the

type emitted by wireless phones; 
• Design wireless phones in a way that minimizes any RF exposure to

the user that is not necessary for device function; and 
• Cooperate in providing users of wireless phones with the best possible

information on possible effects of wireless phone use on human health.
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The FCC has granted an Equipment Authorization for this model phone
with all reported SAR levels evaluated as in compliance with the FCC RF
exposure guidelines. SAR information on this model phone is on file with
the FCC and can be found under the Display Grant section of
http://www.fcc.gov/oet/fccid after searching on FCC ID CJ6CET0200MT. 

Additional information on Specific Absorption Rates (SAR) can be found
on the Cellular Telecommunications & Internet Association (CTIA) web-
site at http://www.phonefacts.net.

* In the United States and Canada, the SAR limit for mobile phones used by the public is 1.6 watts/kg
(W/kg) averaged over one gram of tissue. The standard incorporates a substantial margin of safety to
give additional protection for the public and to account for any variations in measurements.
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power levels, and thus produce RF exposures far below the FCC safety
limits.

4. What are the results of the research done already? 

The research done thus far has produced conflicting results, and many
studies have suffered from flaws in their research methods. Animal
experiments investigating the effects of radiofrequency energy (RF)
exposures characteristic of wireless phones have yielded conflicting
results that often cannot be repeated in other laboratories. A few animal
studies, however, have suggested that low levels of RF could accelerate the
development of cancer in laboratory animals. However, many of the
studies that showed increased tumor development used animals that had
been genetically engineered or treated with cancer-causing chemicals so
as to be pre-disposed to develop cancer in the absence of RF exposure.
Other studies exposed the animals to RF for up to 22 hours per day. These
conditions are not similar to the conditions under which people use
wireless phones, so we don’t know with certainty what the results of such
studies mean for human health.
Three large epidemiology studies have been published since December 2000. Between
them, the studies investigated any possible association between the use of wireless
phones and primary brain cancer, glioma, meningioma, or acoustic neuroma,
tumors of the brain or salivary gland, leukemia, or other cancers. None of the studies
demonstrated the existence of any harmful health effects from wireless phone RF
exposures. However, none of the studies can answer questions about long-term
exposures, since the average period of phone use in these studies was around three
years.

5. What research is needed to decide whether RF exposure from
wireless phones poses a health risk? 

A combination of laboratory studies and epidemiological studies of people
actually using wireless phones would provide some of the data that are
needed. Lifetime animal exposure studies could be completed in a few
years. However, very large numbers of animals would be needed to provide
reliable proof of a cancer promoting effect if one exists. Epidemiological
studies can provide data that is directly applicable to human populations,
but 10 or more years’ follow-up may be needed to provide answers about
some health effects, such as cancer. This is because the interval between
the time of exposure to a cancer-causing agent and the time tumors
develop - if they do - may be many, many years. The interpretation of
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FDA belongs to an interagency working group of the federal agencies that
have responsibility for different aspects of RF safety to ensure coordinated
efforts at the federal level. The following agencies belong to this working
group:
• National Institute for Occupational Safety and Health 
• Environmental Protection Agency 
• Federal Communications Commission 
• Occupational Safety and Health Administration 
• National Telecommunications and Information Administration 

The National Institutes of Health participates in some interagency
working group activities, as well.

FDA shares regulatory responsibilities for wireless phones with the Federal
Communications Commission (FCC). All phones that are sold in the
United States must comply with FCC safety guidelines that limit RF
exposure. FCC relies on FDA and other health agencies for safety questions
about wireless phones.

FCC also regulates the base stations that the wireless phone networks rely
upon. While these base stations operate at higher power than do the
wireless phones themselves, the RF exposures that people get from these
base stations are typically thousands of times lower than those they can
get from wireless phones. Base stations are thus not the subject of the
safety questions discussed in this document.

3. What kinds of phones are the subject of this update? 

The term “wireless phone” refers here to hand-held wireless phones with
built-in antennas, often called “cell,” “mobile,” or “PCS” phones. These
types of wireless phones can expose the user to measurable radiofrequency
energy (RF) because of the short distance between the phone and the
user’s head. These RF exposures are limited by Federal Communications
Commission safety guidelines that were developed with the advice of FDA
and other federal health and safety agencies. When the phone is located at
greater distances from the user, the exposure to RF is drastically lower
because a person’s RF exposure decreases rapidly with increasing distance
from the source. The so-called “cordless phones,” which have a base unit
connected to the telephone wiring in a house, typically operate at far lower
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absorb energy from the wireless phone and is set well below levels known
to have effects.

Manufacturers of wireless phones must report the RF exposure level for
each model of phone to the FCC. The FCC website
(http://www.fcc.gov/oet/rfsafety) gives directions for locating the FCC
identification number on your phone so you can find your phone’s RF
exposure level in the online listing.

8. What has FDA done to measure the radiofrequency energy coming
from wireless phones? 

The Institute of Electrical and Electronic Engineers (IEEE) is developing
a technical standard for measuring the radiofrequency energy (RF)
exposure from wireless phones and other wireless handsets with the
participation and leadership of FDA scientists and engineers. The
standard, “Recommended Practice for Determining the Spatial-Peak
Specific Absorption Rate (SAR) in the Human Body Due to Wireless
Communications devices: Experimental Techniques,” sets forth the first
consistent test methodology for measuring the rate at which RF is
deposited in the heads of wireless phone users. The test method uses a
tissue-simulating model of the human head. Standardized SAR test
methodology is expected to greatly improve the consistency of
measurements made at different laboratories on the same phone. SAR is
the measurement of the amount of energy absorbed in tissue, either by the
whole body or a small part of the body. It is measured in watts/kg (or
milliwatts/g) of matter. This measurement is used to determine whether a
wireless phone complies with safety guidelines.

9. What steps can I take to reduce my exposure to radiofrequency
energy from my wireless phone? 

If there is a risk from these products—and at this point we do not know
that there is—it is probably very small. But if you are concerned about
avoiding even potential risks, you can take a few simple steps to minimize
your exposure to radiofrequency energy (RF). Since time is a key factor in
how much exposure a person receives, reducing the amount of time spent
using a wireless phone will reduce RF exposure.
• If you must conduct extended conversations by wireless phone every

day, you could place more distance between your body and the
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epidemiological studies is hampered by difficulties in measuring actual
RF exposure during day-to-day use of wireless phones. Many factors affect
this measurement, such as the angle at which the phone is held, or which
model of phone is used.

6. What is FDA doing to find out more about the possible health effects
of wireless phone RF? 

FDA is working with the U.S. National Toxicology Program and with
groups of investigators around the world to ensure that high priority
animal studies are conducted to address important questions about the
effects of exposure to radiofrequency energy (RF).

FDA has been a leading participant in the World Health Organization
International Electromagnetic Fields (EMF) Project since its inception in
1996. An influential result of this work has been the development of a
detailed agenda of research needs that has driven the establishment of
new research programs around the world. The Project has also helped
develop a series of public information documents on EMF issues.
FDA and the Cellular Telecommunications & Internet Association (CTIA) have a
formal Cooperative Research and Development Agreement (CRADA) to do research on
wireless phone safety. FDA provides the scientific oversight, obtaining input from
experts in government, industry, and academic organizations. CTIA-funded research
is conducted through contracts to independent investigators. The initial research will
include both laboratory studies and studies of wireless phone users. The CRADA will
also include a broad assessment of additional research needs in the context of the
latest research developments around the world.

7. How can I find out how much radiofrequency energy exposure I can
get by using my wireless phone? 

All phones sold in the United States must comply with Federal
Communications Commission (FCC) guidelines that limit
radiofrequency energy (RF) exposures. FCC established these guidelines
in consultation with FDA and the other federal health and safety agencies.
The FCC limit for RF exposure from wireless telephones is set at a Specific
Absorption Rate (SAR) of 1.6 watts per kilogram (1.6 W/kg). The FCC
limit is consistent with the safety standards developed by the Institute of
Electrical and Electronic Engineering (IEEE) and the National Council
on Radiation Protection and Measurement. The exposure limit takes into
consideration the body’s ability to remove heat from the tissues that
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FDA has tested hearing aids for interference from handheld wireless
phones and helped develop a voluntary standard sponsored by the
Institute of Electrical and Electronic Engineers (IEEE). This standard
specifies test methods and performance requirements for hearing aids and
wireless phones so that that no interference occurs when a person uses a
“compatible” phone and a “compatible” hearing aid at the same time.
This standard was approved by the IEEE in 2000.

FDA continues to monitor the use of wireless phones for possible
interactions with other medical devices. Should harmful interference be
found to occur, FDA will conduct testing to assess the interference and
work to resolve the problem.

12.Where can I find additional information? 

For additional information, please refer to the following resources:
• FDA web page on wireless phones

(http://www.fda.gov/cdrh/phones/index.html) 
• Federal Communications Commission (FCC) RF Safety Program

(http://www.fcc.gov/oet/rfsafety) 
• International Commission on Non-Ionizing Radiation Protection

(http://www.icnirp.de) 
• World Health Organization (WHO) International EMF Project

(http://www.who.int/emf) 
• National Radiological Protection Board (UK)

(http://www.nrpb.org.uk/)
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source of the RF, since the exposure level drops off dramatically with
distance. For example, you could use a headset and carry the
wireless phone away from your body or use a wireless phone
connected to a remote antenna.

Again, the scientific data do not demonstrate that wireless phones are
harmful. But if you are concerned about the RF exposure from these
products, you can use measures like those described above to reduce your
RF exposure from wireless phone use.

10.What about children using wireless phones? 

The scientific evidence does not show a danger to users of wireless phones,
including children and teenagers. If you want to take steps to lower
exposure to radiofrequency energy (RF), the measures described above
would apply to children and teenagers using wireless phones. Reducing
the time of wireless phone use and increasing the distance between the
user and the RF source will reduce RF exposure.

Some groups sponsored by other national governments have advised that
children be discouraged from using wireless phones at all. For example,
the government in the United Kingdom distributed leaflets containing
such a recommendation in December 2000. They noted that no evidence
exists that using a wireless phone causes brain tumors or other ill effects.
Their recommendation to limit wireless phone use by children was strictly
precautionary; it was not based on scientific evidence that any health
hazard exists.

11.What about wireless phone interference with medical equipment? 

Radiofrequency energy (RF) from wireless phones can interact with some
electronic devices. For this reason, FDA helped develop a detailed test
method to measure electromagnetic interference (EMI) of implanted
cardiac pacemakers and defibrillators from wireless telephones. This test
method is now part of a standard sponsored by the Association for the
Advancement of Medical instrumentation (AAMI). The final draft, a joint
effort by FDA, medical device manufacturers, and many other groups, was
completed in late 2000. This standard will allow manufacturers to ensure
that cardiac pacemakers and defibrillators are safe from wireless phone
EMI.
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Section 4B

Manufacturer’s Warranty

In This Section

� Manufacturer’s Warranty

This section contains the manufacturer’s warranty for your device.

For information about the Terms and Conditions of your PCS Service, please
see the Start Here guide included with your device. For the most recent version
of the Terms and Conditions, please visit www.sprintpcs.com.
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Owner’s Record
The model number, regulatory number and serial number are located on
a nameplate inside the battery compartment. Record the serial number in
the space provided below. This will be helpful if you need to contact us
about your device in the future.

Model: PCS Device 2032SP

Serial No.: 

User Guide Proprietary Notice
CDMA Technology is licensed by QUALCOMM Incorporated under one or
more of the following patents:

4,901,307   5,109,390   5,267,262   5,416,797   

5,506,865   5,544,196   5,657,420   5,101,501   

5,267,261   5,414,796   5,504,773   5,535,239   

5,600,754   5,778,338   5,228,054   5,337,338   

5,710,784   5,056,109   5,568,483   5,659,569   

5,490,165   5,511,073 
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touchscreen or outside casing. This limited warranty also does not extend
to any product from which the electronic or mechanical serial number
has been removed or to any product that has been: (a) damaged or
rendered defective by misuse, abuse, accident or other external causes
such as fire, flooding, dirt, sand, weather conditions, battery leakage,
blown fuse, theft or improper usage of an electrical source; (b) subjected
to unauthorized modification, alteration or repair; (c) damaged from
moisture, humidity or extreme environmental conditions; or, (d)
operated in an unsuitable environment or in a manner for which it is not
intended. Purchasers will be charged for all product repairs for damage or
failure not covered by this limited warranty.

Audiovox disclaims liability for geographic coverage, inadequate signal
reception or communications range or for operation of the cellular system
as a whole.

ANY IMPLIED WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF
MERCHANTABILITY, SHALL BE LIMITED TO THE DURATION OF THIS
WRITTEN WARRANTY. ANY ACTION FOR BREACH OF ANY WARRANTY
HEREUNDER INCLUDING ANY IMPLIED WARRANTY OF
MERCHANTABILITY MUST BE BROUGHT WITHIN A PERIOD OF 24
MONTHS FROM DATE OF ORIGINAL PURCHASE. IN NO CASE SHALL THE
COMPANY BE LIABLE FOR ANY CONSEQUENTIAL OR INCIDENTAL
DAMAGES FOR BREACH OF THIS OR ANY OTHER WARRANTY, EXPRESS
OR IMPLIED, WHATSOEVER.

Some states or jurisdictions do not allow limitations on how long an
implied warranty lasts or the exclusion or limitation of incidental or
consequential damages for consumer products, so the above exclusions or
limitations may not apply to you. This Limited Warranty gives you specific
legal rights, and you may also have other rights that may vary from state
to state or jurisdiction to jurisdiction. You are advised to consult
applicable laws for a full determination of your rights.
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Manufacturer’s Warranty
ONE YEAR LIMITED WARRANTY

Audiovox Communications Corp. (“Audiovox”) warrants to the original
retail purchaser (“Purchaser”) that this Audiovox® product will be free
from defects in materials and workmanship under normal consumer use
for one year from the date of original purchase from Audiovox or an
Audiovox authorized reseller. Your dated sales receipt showing the date of
purchase is your proof of the purchase date.

WARRANTY LIMITATIONS

Within the first twelve (12) months from date of purchase, Audiovox’s sole
obligation under this express warranty shall be to repair or replace the
defective product or parts with new or reconditioned parts, at its option.
Reconditioned parts will be equivalent or superior in performance to new
parts. If neither repair nor replacement is reasonably available, Audiovox
may, in its sole discretion, refund to Purchaser the purchase price paid for
the product.

THE EXTENT OF AUDIOVOX’S LIABILITY UNDER THIS WARRANTY IS
LIMITED TO THE REPAIR OR REPLACEMENT AS PROVIDED ABOVE
AND, IN NO EVENT, SHALL AUDIOVOX’S LIABILITY EXCEED THE
PURCHASE PRICE PAID BY PURCHASER FOR THE PRODUCT.

Accessory products, including those listed in the applicable Audiovox
catalogue, are not covered under this Limited Warranty.

Audiovox shall not be responsible for Purchaser’s software, firmware,
information or memory data contained in, stored on, or integrated with
any products returned to Audiovox for repair, whether under warranty or
not. Audiovox is not liable for any damages caused by the product or the
failure of the product to perform, including lost profits, lost savings,
incidental damages or consequential damages. Audiovox is not liable for
any claim made by a third party or made by you for a third party.

This Warranty extends only to product purchased in the United States and
Canada and it is not transferable or assignable.

This limited warranty does not apply to physical damage to the surface of
the product, including breakage, cracks or scratches on the LCD
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A PERIOD OF 18 MONTHS FROM DATE OF ORIGINAL PURCHASE. IN NO
CASE SHALL THE COMPANY BE LIABLE FOR ANY SPECIAL
CONSEQUENTIAL OR INCIDENTAL DAMAGES FOR BREACH OF THIS OR
ANY OTHER WARRANTY, EXPRESS OR IMPLIED, WHATSOEVER. THE
COMPANY SHALL NOT BE LIABLE FOR THE DELAY IN RENDERING
SERVICE UNDER THIS WARRANTY OR LOSS OF USE DURING THE TIME
THE PRODUCT IS BEING REPAIRED OR REPLACED.

No person or representative is authorized to assume for the Company any
liability other than expressed herein in connection with the sale of this
product.

Some states or provinces do not allow limitations on how long an implied
warranty lasts or the exclusion or limitation of incidental or
consequential damage so the above limitation or exclusions may not
apply to you. This Warranty gives you specific legal rights, and you may
also have other rights which vary from state to state or province to
province.

IN USA: AUDIOVOX COMMUNICATIONS CORP.

555 Wireless Blvd.

Hauppauge, NY  11788

(800) 229-1235

IN CANADA: AUDIOVOX CANADA LTD.

5155 Spectrum Way, Unit #5

Mississauga, Ontario L4W 5A1

(800) 465-9672
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SOFTWARE

THIS AUDIOVOX® PRODUCT MAY INCLUDE THIRD PARTY SOFTWARE,
THE USE OF WHICH IS GOVERNED BY THE APPLICABLE SOFTWARE
LICENSE, END-USER LICENSE OR PROGRAM LICENSE AGREEMENT.
THIS LIMITED WARRANTY DOES NOT APPLY TO SUCH THIRD PARTY
SOFTWARE AND SUCH SOFTWARE IS PROVIDED “AS IS”. FOR THE
APPLICABLE WARRANTY, PLEASE REFER TO THE SOFTWARE LICENSE,
END-USER LICENSE OR PROGRAM LICENSE GOVERNING THE USE OF
SUCH SOFTWARE OR THE DOCUMENTATION ACCOMPANYING SUCH
SOFTWARE. 

Audiovox does not warrant that any contained software products will meet
Purchaser’s requirements or will work together with any hardware or
software products supplied by third parties, that the software products will
be error-free or that software defects will be corrected.

WARRANTY SERVICE

Purchaser must contact Audiovox within the applicable warranty period
to obtain warranty service authorization. Audiovox is not responsible for
products or parts received without a warranty service authorization. 

BE SURE TO BACK UP DATA AND REMOVE ANY CONFIDENTIAL,
PROPRIETARY, OR PERSONAL INFORMATION BEFORE RETURNING
PRODUCT FOR SERVICE. AUDIOVOX IS NOT RESPONSIBLE FOR
DAMAGE TO OR LOSS OF ANY PROGRAMS, DATA OR REMOVABLE
STORAGE MEDIA.

Repaired or replacement products will be shipped to Purchaser at
Audiovox’s expense. 

THE EXTENT OF THE COMPANY’S LIABILITY UNDER THIS WARRANTY
IS LIMITED TO THE REPAIR OR REPLACEMENT PROVIDED ABOVE
AND, IN NO EVENT, SHALL THE COMPANY’S LAIBILITY EXCEED THE
PURCHASE PRICE PAID BY PURCHASER FOR THE PRODUCT.

ANY IMPLIED WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE SHALL
BE LIMITED TO THE DURATION OF THIS WRITTEN WARRANTY. ANY
ACTION FOR BREACH OF ANY WARRANTY MUST BE BROUGHT WITHIN
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